# Contents

Introduction .......................................................................................................................... 5
What’s New in Partition Manager 12 .................................................................................. 5
Product Components ........................................................................................................... 5
Features Overview ................................................................................................................ 5

## Features

- User Friendly Fault Minimizing Interface ....................................................................... 5
- Backup Facilities ............................................................................................................... 6
- Restore Facilities .............................................................................................................. 6
- Boot Management Facilities .......................................................................................... 6
- Partition/Hard Disk Management Facilities .................................................................. 6
- Auxiliary Facilities .......................................................................................................... 7

## Supported Technologies

- ........................................................................................................................................ 7

## Supported File Systems

- ........................................................................................................................................ 8

## Supported Media

- ........................................................................................................................................ 8

## Getting Started

- System Requirements ........................................................................................................ 8
- Installation ......................................................................................................................... 9

### First Start

- ........................................................................................................................................ 10

### Building Recovery Media

- ........................................................................................................................................ 11

### Booting from the Linux/DOS Recovery Media

- Startup ............................................................................................................................... 12
- Boot menu ......................................................................................................................... 13

## Basic Concepts

- GPT versus MBR................................................................................................................ 15
- Apple Boot Camp ............................................................................................................. 15
- 64-bit Support ................................................................................................................... 16
- Drive Partitioning ............................................................................................................ 16

## Windows Components

- ........................................................................................................................................ 16

## Interface Overview

- General Layout .................................................................................................................. 17
- Main Menu ........................................................................................................................ 18
- Tool Bar .............................................................................................................................. 20
- Virtual Operations Bar ..................................................................................................... 21

Copyright © 1994-2013 Paragon Software GmbH. All rights reserved.
### Typical Scenarios

65

### Backup Scenarios

65

- Backing up a hard disk or partition to a network drive
- Backing up a dual boot Mac to an external USB drive

### Recovery Scenarios

69

- Fixing MBR after a boot virus attack
- Fixing Windows startup ability
- Restoring a dual boot Mac from an external USB drive
- Copying of data from the corrupted system disk to another hard disk
- Burning of data from the corrupted system disk to CD/DVD
- Copying of data from a backup to the corrupted system partition
- Restoring separate files and folders from a backup

### Resize Scenarios

85

- Creating a new partition to detach operating system from the rest of data
- Increasing size of a system partition by taking unused space of an adjacent partition
- Increasing size of a system partition by taking unused space from any other
- Increasing size of a system partition by taking unused space of an adjacent logical partition
- Separating OS from media data
- Merging a system partition with an adjacent logical partition
- Shrinking a system partition to increase size of a data partition
- Resizing partitions of Apple Boot Camp

### Creating Dual Boot Systems

101

For Windows computers

### Troubleshooter

111

### Glossary

112
Introduction

Paragon Partition Manager™ 12 Home is an integrated set of powerful tools that is specially designed to tackle most of the problems you might face while using PC. A highly intelligent program engine together with built-in advanced recovery facilities make it possible to securely carry out partitioning operations of any complexity without fear to lose precious data.

In this manual you will find the answers to many of the technical questions, which might arise while using the program.

---

What’s New in Partition Manager 12

- **Split Partition Wizard** helps you separate OS and data or different types of data by splitting one partition to two different partitions of the same type and file system.
- **Support of Windows 8.**
- **Support of the restart-free installation.**

Product Components

In order to cope with different tasks, the product contains several components:

- **Windows based set of utilities** is the crucial part of the product. With the help of an easy to use launcher you may find and run tasks of any complexity in the field of data and system protection, hard disk partitioning and cloning, etc.
- **Linux/DOS based recovery environment** is a multi-platform bootable media that enables to run utilities under Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes. Both platforms have their strong sides, for instance Linux can boast support of FireWire (i.e. IEEE1394) or USB devices. It enables to burn CD/DVD discs. However there can be some difficulties with detecting new hardware. DOS in its turn has no problems of that kind but is limited in features. The Linux/DOS recovery environment requires no installation and can be of great help when the system fails to boot. Besides it offers a Windows XP like environment.

Features Overview

This chapter dwells upon key benefits and technical highlights of the product.

Features

Let us list some of the features:

User Friendly Fault Minimizing Interface

- **Graphical representation of the data** to gain a better understanding.
- **A handy Launcher** to easily find and run the required tasks.
- **Comprehensive wizards** to simplify even the most complex operations.

- **A context sensitive hint system** for all functions of the program.

- **Previewing the resulting layout of hard disks before actually executing operations** (so-called virtual operations).

### Backup Facilities

- **Available location for backup images:**
  - *Backup to local mounted partitions.*
  - *Backup to an external mounted storage* to provide for a higher level of data protection and system independence.
  - *Backup to a network drive* to stand a better chance of success in case of a hard disk failure.

- **Back up separate partitions or entire disks.**

### Restore Facilities

- **Restore an entire disk, separate partitions** from the previously created backup image.

> This feature is only available for the bootable recovery environment.

### Boot Management Facilities

- **Boot Manager Setup Wizard** to easily manage several operating systems on one computer.

### Partition/Hard Disk Management Facilities

- **Basic functions for initializing, partitioning and formatting hard disks** (create, format, delete). Instead of the standard Windows disk tools, the program supports all popular file systems.

- **Express Create Partition Wizard** to create a new partition in the most appropriate place of a hard disk, format it to NTFS and then make it available in the system by assigning a drive letter.

- **Split Partition Wizard** helps you separate OS and data or different types of data by splitting one partition to two different partitions of the same type and file system.

- **Merge Partitions Wizard** to consolidate the disk space, which originally belongs to two adjacent partitions (NTFS, FAT16/FAT32), into a single, larger partition.

- **Redistribute Free Space Wizard** to increase free space on one partition by up-taking the on-disk unallocated space and the unused space of other partitions.

- **Express Resize Partitions Wizard** to increase free space on one partition by up-taking the unused space of an adjacent partition of a hard disk (including partitions of Apple Boot Camp).

- **NTFS hot resize upward** to enlarge an NTFS partition (system, locked) without rebooting Windows and interrupting its work.

- **Convert a file system** (FAT16/32, NTFS) without reformatting.

- **Mount a partition** (assign a drive letter) of any file system type to make it available for your operating system.

- **Modify file system parameters** (make active/inactive, hide/unhide, etc.).
Install New OS Wizard to make a system ready to install a new operating system.

Undelete Partitions Wizard to recover an accidentally deleted partition.

Auxiliary Facilities

File Transfer Wizard to make such operations as transferring of files/directories or burning of them to CD/DVD as easy and convenient as possible. Providing access to Paragon backups as regular folders, it may also help to replace corrupted data from a previously created image in case of an operating system failure.

This feature is only available for the bootable recovery environment.

File Transfer Wizard is a handy tool when you have different file systems on the disk, whether they contain an operating system or just data. Volume Explorer will let you explore a file system of any type and provide access to the necessary files and directories regardless of their security attributes.

Volume Explorer is only available for the bootable recovery environment.

Recovery Media Builder to create a bootable recovery media on a CD, DVD disc, or flash memory, which can later be used to boot and recover your computer in case of an operating system failure. Moreover, with its help you can save data from partitions of your hard disk directly to compact discs or burn ISO-images. The utility supports various formats of laser discs: CD-R/RW, DVD-R/RW, DVD+R/RW, DVD-R, DVD+R double layer, Blu-ray and can handle multi-session burning.

Network Configuration Wizard to establish a network connection on a bootable recovery media either to save a backup of a partition/hard disk or just several files on a network computer or retrieve a previously made backup from a network computer for recovery purposes.

Boot Corrector to fix most of the system boot problems that can be a result of a human factor, program error or a boot virus activity.

Boot Corrector is only available for the bootable recovery environment.

Supported Technologies

Along with using innovative technologies from outside, Paragon has developed a number of its own original technologies that make its products unique and attractive for customers:

Paragon Hot Backup™ technology to back up locked partitions and hard disks under Windows NT+ family operating systems providing both high operating efficiency as well as low hardware requirements.

Paragon Power Shield™ technology to provide data consistency in case of a hardware malfunction, power outages or an operating system failure.

Paragon UFSD™ technology to browse partitions of any file system including hidden and unmounted, modify and copy files and folders, etc.

Paragon Hot Resize™ technology to enlarge NTFS partitions (system, locked) without rebooting Windows and interrupting its work.

Paragon Smart Partition™ technology to securely perform hard disk partitioning operations of any complexity.
• **Paragon BTE™** technology to set tasks for execution during the system restart, thus saving from the need to use a bootable media when modifying system partitions.

• **Microsoft Volume Shadow Copy Service (VSS)** to provide the copy/backup infrastructure for the Microsoft Windows XP/Vista/7/Server 2003/2008 operating systems. It offers a reliable mechanism to create consistent point-in-time copies of data known as shadow copies. Developed by Microsoft in close cooperation with the leading copy/backup solution vendors on the market, it is based on a snapshot technology concept.

• **GUID Partition Table (GPT).** It is the next generation of a hard disk partitioning scheme developed to lift restrictions of the old MBR. GPT disks are now supported by Windows Vista/7, Server 2008, Mac OS X and Linux.

### Supported File Systems

- Full read/write access to FAT16/FAT32 partitions.
- Full read/write access to NTFS (Basic Disks) under Windows, Linux and PTS DOS. Compressed NTFS files are also supported.
- Full read/write access to Ext2FS/Ext3FS/Ext4FS partitions.
- Limited read/write access to Apple HFS+ partitions.

> Unfortunately, support of non-Roman characters for the HFS+ file system is unavailable at the moment. The company is about to implement it in the nearest future.

### Supported Media

- Support of both MBR and GPT hard disks (2.2TB+ disks included)
- IDE, SCSI and SATA hard disks
- SSD (Solid State Drive)
- AFD (Advanced Format Drive)
- Non-512B sector size drives
- FireWire (i.e. IEEE1394), USB 1.0, USB 2.0, USB 3.0 hard disks
- PC card storage devices (MBR and GPT flash memory, etc.)

### Getting Started

In this chapter you will find all the information necessary to get the product ready to use.

### System Requirements

**For the Windows installation package**

- Operating systems:
  - Windows 2000 Professional (32 bit only)
  - Windows XP (32 and 64 bit)
- Windows Vista (32 and 64 bit)
- Windows 7 (32 and 64 bit)
- Windows 8 (32 and 64 bit)

- Internet Explorer 5.0 or higher
- Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
- 128 MB of RAM (256+ recommended)
- Hard disk drive with 250 MB of available space
- SVGA video adapter and monitor
- Keyboard
- Mouse

During the installation additional free space (up to 1GB) will be required.

For the Linux bootable environment

- Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed
- 256 MB of RAM
- SVGA video adapter and monitor
- Keyboard
- Mouse

Additional requirements

- Network card to send/retrieve data to/from a network computer
- Recordable CD/DVD drive to burn data to compact discs
- External USB hard drive to store data.

Installation

To install Paragon Partition Manager 12, please do the following:

1. **Run Setup Application.** Click on the *.MSI file. This application will guide you through the process of the program installation. The setup utility is compiled with the InstallShield SDK, hence it contains the standard user interface and set of installation steps.

In case there is some previous version of the program installed on the computer, the program will offer the user to uninstall it first.

2. **Starting Setup.** The Welcome page informs that the application is being installed. Click the Next button to continue.
3. **Confirm License Agreement.** The License Agreement page displays the Paragon License Agreement. Read the agreement and then select the appropriate option to accept. If you do not agree with any conditions stated there, the installation process will be interrupted. By clicking the Print button, the License Agreement may also be printed out.

4. **Provide Registration Information.** On the Registration page you are to provide your product key and serial number.

5. **Provide Customer Information.** On the Customer Information page you are to provide the standard information, i.e. a user name and an organization. Besides you need to decide whether to make the program available for all users of this computer (if several) or only for the current one.

6. **Select an Installation Folder.** The Destination Folder page allows you to choose a folder where the program will be installed. By default, the installation folder will be created as:
   
   C:\Program Files\Paragon\Paragon Partition Manager 12. To select another folder, click the Change… button. After you have selected the required folder, click the Next button to continue.

---

Do not install the program on network drives. Do not use Terminal Server sessions to install and run the program. In both cases, the program functionality will be limited.

---

7. **Confirm Installation.** On the Ready to Install the Program page click the Install button to start the installation or the Back button to return to any of the previous pages and modify the installation settings.

8. **Copying Files.** The Copying Files page shows the overall progress of the installation. Click the Cancel button to abort the setup.

9. **Finishing the Installation.** The Final page reports the end of the setup process. Click the Finish button to complete the wizard.

**First Start**

To start Paragon Partition Manager 12 under Windows, please click the Windows Start button and then select **Programs > Paragon Partition Manager™ 12 > Paragon Partition Manager™**.

---

The program provides wide opportunities in the field of hard disk structure modification, so just to be on the safe side, please make a backup of your data before carrying out any operation.

---

The first component that will be displayed is called the Express Launcher. Thanks to a well thought-out categorization and hint system, it provides quick and easy access to wizards and utilities that we consider worth using on a regular basis. With its help you can also start up the traditional launcher, the help system or go to the program’s home page.

Copyright © 1994-2013 Paragon Software GmbH. All rights reserved.
To know more on how to handle the product’s interface and accomplish typical operations, please consult the Windows Components chapter.

Building Recovery Media

Recovery Media Builder can help you accomplish the following operations:

- Prepare the Linux/DOS recovery environment (included in the installation package) on external media (CD, DVD, or flash memory) to boot and run utilities under Linux or PTS DOS, and that way to get access to your hard disk for maintenance or recovery purposes (strongly recommended);
- Prepare a custom Linux/DOS recovery environment by adding any data you like to the standard image;
- Prepare a bootable recovery environment from any ISO image;
- Create from the master CD the Linux/DOS recovery environment on a CD/DVD disc, or flash memory.

Below you can find how to build our Linux/DOS based recovery environment on a thumb drive:

1. Plug in a thumb drive of at least 250 MBs in size. Please note all data on that drive will be deleted.
2. In the Main Menu: select Tools > Recovery Media Builder...

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

3. On the Wizard’s Welcome page, click the Next button.
4. Select the **Flash Memory** option.

5. Select the **Typical** option.

6. Select the required thumb drive from the list of flash memory devices available in the system at the moment (if several).

7. You will have to confirm the operation.

---

**Booting from the Linux/DOS Recovery Media**

The Linux/DOS recovery environment can be used to boot your computer into Linux or PTS DOS to get access to your hard disk for maintenance or recovery purposes. It also has the PTS DOS safe mode, which may help in a number of non-standard situations such as interfering hardware settings or serious problems on the hardware level. In this case, only basic files and drivers (such as hard disk drivers, a monitor driver, and a keyboard driver) will be loaded.

**Startup**

To start working with the Linux/DOS recovery environment, please take the following steps:

1. Start up the computer from our Linux/DOS recovery media.

---

**Recovery Media Builder** can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive.

**To automatically boot from the recovery media please make sure the on-board BIOS is set**
up to boot from CD/USB first.

2. Launch a boot mode you need (Normal, Safe, Low-Graphics Safe) in the Boot menu.

By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. Click on the required operation to start. Hints on the selected at the moment item will help you make the right choice.

4. Consult the help system by pressing **ALT+F1** to know more on the subject.

**Boot menu**

The Boot menu contains the following commands:

- **Normal Mode.** Boot into the Linux normal mode. This mode uses the full set of drivers (recommended);
- **Safe Mode.** Boot into the PTS DOS mode. This mode can be used as an alternative of the Linux normal mode if it fails to work properly;
- **Low-Graphics Safe Mode.** Boot into the PTS DOS safe mode. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu;
- **Floppy Disk.** Reboot the computer from a system floppy disk;
- **Hard Disk 0.** Boot from the primary hard disk;
- **Find OS(s) on your hard disks.** The program will scan hard disks of your computer to find any bootable operating system.

To move within the menu, please use the arrow keys of the computer keyboard.

While working with the recovery environment you might experience some inconvenience caused by possible video artifacts. It is just a result of changing video modes and in no way will affect the program functionality. If this is the case, please wait a bit and everything will be OK.

**Normal Mode**

When the Normal mode is selected, the Linux launch menu appears:
• **Partition Manager** (enables to run wizards and dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration);

• **Express Resize Wizard** (enables to increase free space on one partition by up-taking the unused space of an adjacent partition);

• **Restore Wizard** (allows restoring hard disks and partitions);

• **File Transfer Wizard** (allows coping files/folders to another disk or a partition as well as recording them to CD/DVD);

• **Boot Corrector** (helps to correct the Windows System Registry without Windows being loaded);

• **Network Configurator** (enables to establish a network connection under Linux);

---

If you are going to use network resources, first launch the Network Configuration Wizard to establish a network connection.

---

• **Log Saver** (helps to collect and send the necessary log files to the Technical Support);

• **Eject CD/DVD**;

• **Reboot the computer**;

• **Power off the computer**.

To move within the menu, please use the arrow keys of the computer keyboard.

**Safe Mode**

When the Safe mode is selected, the PTS DOS launch menu appears. It has nearly the same functionality as for the Normal mode except for the **Network Configurator** and **Log Saver** commands. Besides due to certain limitations of the PTS DOS environment, there is no possibility to burn CD/DVD discs.
**Low Graphics Safe Mode**

When the Low Graphics mode is selected, the PTS DOS launch menu appears. It has the same functionality and looks similar to the Safe mode but graphically simpler.

![Partion Manager](image)

**Basic Concepts**

This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general notion of the operation performance and makes it easier for the user to operate the program.

**GPT versus MBR**

GUID Partition Table (GPT) is the next generation of a hard disk partitioning scheme developed to lift restrictions of the old MBR. Being a part of the Extensible Firmware Interface (EFI) standard proposed by Intel to replace the outdated PC BIOS, it offers a number of crucial benefits:

- Up to 128 primary partitions for the Windows implementation (only 4 in MBR);
- The maximum allowed partition size is 18 exabytes (only 2 terabytes in MBR);
- More reliable thanks to replication and cyclic redundancy check (CRC) protection of the partition table;
- A well defined and fully self-identifying partition format (data critical to the platform operation is located in partitions, but not in un-partitioned or hidden sectors as this is the case with MBR)

**Apple Boot Camp**

Boot Camp is a special utility to help you set up a dual boot system (Mac OS X and 32-bit Windows XP/Vista) on Intel-based Macs. It enables to securely re-partition your hard disk (resize an existing HFS+ partition to create a separate partition for Windows) and then launch the installation process. With Boot Camp all the necessary drivers will be at your disposal. Moreover after Windows has been installed it will serve as a boot manager to choose what operating system to start up.

---

---

It is strongly recommended not to modify the hard disk configuration with Windows Disk Manager. Otherwise it may lead to unexpected consequences, right up to BSOD and inability to boot in Windows XP/Vista. Please use our program to correctly update both MBR and GPT.

---
**64-bit Support**

The bulk of software today is written for a 32-bit processor. It can meet the requirements of almost any end user. However that is not the case when dealing with servers processing large amounts of data with complex calculations of very large numbers. That is where 64-bit architecture comes into play.

It can boast improved scalability for business applications that enables to support more customer databases and more simultaneous users on each server. Besides a 64-bit kernel can access more system resources, such as memory allocation per user. A 64-bit processor can handle over 4 billion times more memory addresses than a 32-bit processor. With these resources, even a very large database can be cached in memory.

Although many business applications run without problems on 32-bit systems, others have grown so complex that they use up the 4 GB memory limitation of a 32-bit address space. With this large amount of data, fewer memory resources are available to meet memory needs. On a 64-bit server, most queries are able to perform in the buffers available to the database.

Some 32-bit applications make the transition to the 64-bit environment seamlessly others do not. For instance, system-level utilities and programs that provide direct hardware access are likely to fail. Our program offers a full-fledged support of the 64-bit architecture providing fault-tolerant work for such system dependent modules as Hot Processing.

**Drive Partitioning**

As you probably know a hard drive is to be split into one or more partitions, since it cannot hold data until it is carved up and space is set aside for an operating system. Until recently most PCs used to have just one partition, which filled the entire hard disk and contained an OS. The situation has changed however, thanks to new cost-effective high capacity hard drives, thus opening up numerous possibilities for PC users, such as editing video, archiving music, backing up CD images, etc. Huge increase in space is great, but it poses a number of problems, most important of which are effective data organization and speed.

Large drives are always going to take longer to search than smaller volumes, and an operating system is going to have its work cut out both finding and organizing files. It is for this reason that many people decide to invest in multiple hard drives, but there is an easy solution – drive partitioning. Partitioning lets you divide a single physical drive into a number of logical drives, each of which servers as a container with its own drive letter and volume label, thus enabling the operating system to process data more efficiently. Besides partitioning makes it possible to organize data so that it is easy to find and manage. You can set aside, for instance, 40 GB of a 160 GB hard drive for the OS, 70 GB for storing video and another 50 GB for your favorite music collections to provide transparent data storage.

It is also worth mentioning to that with a hard drive properly partitioned, such routine operations as files de-fragmentation or consistency check will not be that annoying and time-consuming any more.

By detaching the OS from the rest of the data you can tackle one more crucial issue – in case of a system malfunction, you can get the system back on track in minutes by recovering it from a backup image located on the other partition of the hard drive.

But that is not all drive partitioning may be used for. If you are willing to play games in Windows while browsing the Internet in Linux, 100-percent sure that no virus will attack your PC, drive partitioning is a necessity. In order to run several OSs on a single hard drive you are to create a corresponding number of partitions to effectively delineate the boundaries of each OS.

**Windows Components**

In the given section you can find all the information necessary to successfully work with the Windows version of the product.
Interface Overview

This chapter introduces the graphical interface of the program. The design of the interface precludes any mistake being made on the part of the user. Most operations are performed through the system of wizards. Buttons and menus are accompanied by easy understandable icons. Nevertheless, any problems that might occur while managing the program can be tackled by reading this very chapter.

General Layout

When you start the program, the first component that is displayed is called the Launcher. It enables to run wizards and dialogs, to specify program settings, to visualize the operating environment and the hard disk configuration.

The Launcher’s window can be conditionally subdivided into several sections that differ in their purpose and functionality:

1. Main Menu
2. Tool Bar
3. Virtual Operations Bar
4. Common Tasks Bar
5. Explorer Bar
6. Disk Map
7. Partition List
A number of panels offer similar functionality with a synchronized layout. The program enables to conceal some of them to simplify the interface management.

All panels are separated by vertical and horizontal expandable sliders, allowing the user to customize the screen layout.

**Main Menu**

The Main Menu provides access to the entire functionality of the program. The available functions are as listed below:

<table>
<thead>
<tr>
<th>MENU ITEM</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tools</strong></td>
<td></td>
</tr>
<tr>
<td><strong>View Log Files</strong></td>
<td>View logs on the carried out operations</td>
</tr>
<tr>
<td><strong>Send Log Files</strong></td>
<td>Compress and send the log to the Paragon Support Team</td>
</tr>
<tr>
<td><strong>Log Saver</strong></td>
<td>A wizard will help you collect and send logs to the Paragon Support Team</td>
</tr>
<tr>
<td><strong>Setup Boot Manager...</strong></td>
<td>Manage several operating systems on one computer</td>
</tr>
<tr>
<td><strong>Recovery Media Builder...</strong></td>
<td>Restore the system even when the current operating system cannot boot anymore</td>
</tr>
<tr>
<td><strong>Settings...</strong></td>
<td>Edit the general settings of the program</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Exit the program</td>
</tr>
<tr>
<td><strong>Changes</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Undo 'the last virtual operation'</strong></td>
<td>Cancel the last virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td><strong>Redo 'the last virtual operation'</strong></td>
<td>Cancel the last undo virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td><strong>View Changes...</strong></td>
<td>Display the List of Pending Operations</td>
</tr>
<tr>
<td><strong>Apply Changes</strong></td>
<td>Launch the real execution of virtual operations</td>
</tr>
<tr>
<td><strong>Discard All Changes</strong></td>
<td>Cancel all virtual operations on the List of Pending Operations</td>
</tr>
<tr>
<td><strong>Reload Disk Info</strong></td>
<td>Refresh the current information about disks</td>
</tr>
<tr>
<td><strong>Wizards</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Express Create Partition...</strong></td>
<td>Create an NTFS partition and make it ready for work</td>
</tr>
<tr>
<td><strong>Create Partition...</strong></td>
<td>Create a partition of any file system</td>
</tr>
<tr>
<td><strong>Format Partition...</strong></td>
<td>Format a partition of any file system</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Delete Partition...</strong></td>
<td>Delete a partition of any file system</td>
</tr>
<tr>
<td><strong>Express Resize Partitions...</strong></td>
<td>Increase free space on one partition by up-taking the unused space of an adjacent partition</td>
</tr>
<tr>
<td><strong>Undelete Partitions...</strong></td>
<td>Recover an accidentally deleted partition</td>
</tr>
<tr>
<td><strong>Merge Partitions...</strong></td>
<td>Merge adjacent partitions of NTFS, FAT or FAT32 file systems</td>
</tr>
<tr>
<td><strong>Split Partition Wizard...</strong></td>
<td>Separate OS and data or different types of data by splitting one partition to two different partitions of the same type and file system</td>
</tr>
<tr>
<td><strong>Redistribute Free Space...</strong></td>
<td>Redistribute available disk space of existed partitions</td>
</tr>
<tr>
<td><strong>Install New OS...</strong></td>
<td>Make your system ready to install a new operating system</td>
</tr>
<tr>
<td><strong>Simple Backup...</strong></td>
<td>Create a sector-based archive of an entire hard disk or separate partitions</td>
</tr>
<tr>
<td><strong>Hard Disk</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Update MBR</strong></td>
<td>Update MBR (Master Boot Record) of the selected hard disk</td>
</tr>
<tr>
<td><strong>Edit/View Sectors...</strong></td>
<td>View/edit sectors of the selected hard disk</td>
</tr>
<tr>
<td><strong>Properties...</strong></td>
<td>Get in-depth information on the properties of selected hard disk</td>
</tr>
<tr>
<td><strong>Partition</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Create Partition...</strong></td>
<td>Create a partition</td>
</tr>
<tr>
<td><strong>Format Partition...</strong></td>
<td>Format a partition</td>
</tr>
<tr>
<td><strong>Delete Partition...</strong></td>
<td>Delete a partition</td>
</tr>
<tr>
<td><strong>Move/Resize</strong></td>
<td>Move/Resize the selected partition</td>
</tr>
<tr>
<td><strong>Convert File System...</strong></td>
<td>Convert file system of the selected partition</td>
</tr>
<tr>
<td><strong>Assign Drive Letter...</strong></td>
<td>Assign drive letter to the selected partition</td>
</tr>
<tr>
<td><strong>Remove Drive Letter...</strong></td>
<td>Remove drive letter for the selected partition</td>
</tr>
<tr>
<td><strong>Hide Partition...</strong></td>
<td>Make the selected partition unavailable for the operating system</td>
</tr>
<tr>
<td><strong>Unhide Partition...</strong></td>
<td>Make the selected partition available for the operating system</td>
</tr>
<tr>
<td><strong>Mark Partition as Active</strong></td>
<td>Make the selected partition bootable by default</td>
</tr>
<tr>
<td><strong>Mark Partition as Inactive</strong></td>
<td>Make the selected partition non-bootable by default</td>
</tr>
<tr>
<td><strong>Change Volume Label...</strong></td>
<td>Change volume label of the selected partition</td>
</tr>
<tr>
<td><strong>Make Partition Primary...</strong></td>
<td>Make the selected partition Primary</td>
</tr>
<tr>
<td><strong>Make Partition Logical...</strong></td>
<td>Make the selected partition Logical</td>
</tr>
<tr>
<td><strong>Test Surface</strong>…</td>
<td>Test surface of the selected partition/block of free space</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Check File System Integrity</strong>…</td>
<td>Check the selected partition for possible file system errors</td>
</tr>
<tr>
<td><strong>Edit/View Sectors</strong>…</td>
<td>View/edit sectors of the selected partition</td>
</tr>
<tr>
<td><strong>Properties</strong>…</td>
<td>Get in-depth information on the properties of selected partition</td>
</tr>
</tbody>
</table>

**View**

<table>
<thead>
<tr>
<th><strong>Layouts</strong></th>
<th>Manage the Launcher layout with several predefined profiles</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Toolbar</strong></td>
<td>Manage the Tool Bar representation: show / hide standard and navigation buttons, text labels and large icons</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td>Display the Status Bar</td>
</tr>
<tr>
<td><strong>Common Tasks Bar</strong></td>
<td>Display the Common Tasks Bar</td>
</tr>
<tr>
<td><strong>Disk Map Legend</strong></td>
<td>Display the Disk Map legend</td>
</tr>
<tr>
<td><strong>Properties and Commands</strong></td>
<td>Display the Explorer Bar</td>
</tr>
<tr>
<td><strong>Disk Map Location</strong></td>
<td>Select whether the Disk Map will be located on the top of the main window or at the bottom</td>
</tr>
</tbody>
</table>

**Help**

<table>
<thead>
<tr>
<th><strong>Help</strong></th>
<th>Open the Help system (you can also do it by pressing F1)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>About</strong></td>
<td>Open the dialog with information about the program</td>
</tr>
</tbody>
</table>

---

The Main Menu contents available at the moment may vary depending on the selected object.

**Tool Bar**

The Toolbar provides fast access to the most frequently used operations:

<table>
<thead>
<tr>
<th><strong>BUTTON</strong></th>
<th><strong>FUNCTIONALITY</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟</td>
<td>Create an image of a hard disk or partition</td>
</tr>
<tr>
<td>🔄</td>
<td>Increase free space on one partition by up-taking the unused space of an adjacent partition</td>
</tr>
<tr>
<td>🔄</td>
<td>Collect and send logs to Support</td>
</tr>
</tbody>
</table>
Virtual Operations Bar

The program supports previewing the resulting layout of hard disks before actually executing operations (so-called virtual mode of execution). In fact, when the virtual mode is enabled, the program does not accomplish operations immediately, but places them on the List of Pending Operations for later execution.

The Virtual Operations Bar enables to manage pending operations.

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Cancel the last virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td>🔄</td>
<td>Cancel the last undo virtual operation on the List of Pending Operations</td>
</tr>
<tr>
<td>🔄</td>
<td>Display the List of Pending Operations</td>
</tr>
<tr>
<td>✅</td>
<td>Launch the real execution of virtual operations</td>
</tr>
<tr>
<td>✗</td>
<td>Cancel all virtual operations on the List of Pending Operations</td>
</tr>
</tbody>
</table>

Virtual mode is an effective way of protection from any troubles, since no operations will be executed until clicking the Apply button for confirmation, thus giving a second chance to weigh all pros and cons of this or that particular operation. The program politely reminds the user that there are unsaved changes by showing the following window:

Common Tasks Bar

The Common Tasks Bar is located on the left side of the main window. It is intended for easy access to the program’s wizards.

The bar contains several tabs. Each tab includes a separate button bar which can be folded by clicking it.

<table>
<thead>
<tr>
<th>Basic Partitioning Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄 Express Create</td>
</tr>
<tr>
<td><strong>Advanced Partitioning Tasks</strong></td>
</tr>
<tr>
<td>--------------------------------</td>
</tr>
<tr>
<td>Starting the Create Partition Wizard to create a partition of any file system.</td>
</tr>
<tr>
<td>Starting the Format Partition Wizard to format an existing partition to one of the file systems supported by the program.</td>
</tr>
<tr>
<td>Starting the Delete Partition Wizard to delete a partition of any file system.</td>
</tr>
<tr>
<td><strong>Backup Tasks</strong></td>
</tr>
<tr>
<td>Starting the Sector Backup Wizard to create an archive of a hard disk or separate partitions.</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
</tr>
<tr>
<td>Starting the File Transfer Wizard to transfer data from any media. Besides it provides access to Paragon backups as regular folders to browse through their contents or copy required files.</td>
</tr>
<tr>
<td>Starting the Boot Manager Setup Wizard to easily manage several operating systems on one computer.</td>
</tr>
<tr>
<td>Starting the Install New OS Wizard to install a new operating system.</td>
</tr>
<tr>
<td>Starting the Log Saver Wizard to collect and send logs to Support.</td>
</tr>
</tbody>
</table>

**Disk Map**

The Disk Map is displayed in the Explorer Bar when the Disk View tab is selected. It is located either at the top or at the bottom of the window, depending on the state of the Disk Map Location option (Main Menu: View > Disk Map Location).
As the name infers, the Disk Map displays the layout of physical and logical disks. Physical disks are represented with rectangle bars that contain small-sized bars. These small-sized bars represent logical disks. Their color depends on the file system of the appropriate partition.

Large-sized bars display the following information about physical disks:
- Manufacturer,
- Model.

Small-sized bars display the following information about logical disks:
- Serial number,
- Drive letter,
- Total size,
- File system.

Furthermore, it is possible to estimate the used disk space by looking at the size of the bar’s shaded area. The program offers to choose from several types of the disk layout scaling. It’s done especially to increase the program usability. For instance, if you’ve got a high capacity hard drive containing both very large (more than 100 GB) and rather small (less than 10 GB) partitions, you can select the logarithmic type to make all partitions readable, otherwise (selecting the linear type) you won’t be able to see small partitions at all, but thing strips. On the other hand, if the proportional disk layout is critical for you, the linear type is exactly what you need.

Nevertheless there’s a compromise solution – linear scaling with the minimal limit to small partitions. So if a partition is too small it will remain readable.

Just click on the arrow icon on the top right side of the Disk Map to select the desired scaling type.

Disk Map is synchronized with the Explorer Bar. Thus by selecting a disk on the Disk Map, the Explorer Bar will automatically display detailed information on it.

---

**The drag-and-drop functionality is not available when the logarithmic type of the disk layout is selected.**

### Explorer Bar

The Explorer Bar is located in the center of the main window which emphasizes its importance. The bar displays reference information including:
- The help system
- General information on the product including its name, version and a list of helpful links
- Detailed information about disks selected on the Disk Map
- Volume Explorer utility
- Disk Editor utility

According to these categories the Explorer Bar has several tabs:

- **Disk View**, which offers the user the following options:
  - [Partition List](#) to get a clear-cut picture of the current state of the system hard disks/partitions
  - [Disk Editor](#) to view/edit sectors of the selected partition/hard disk
  - [Volume Explorer](#) to browse and export contents of the selected partition/hard disk
  - [Properties](#) to view detailed information on the selected partition/hard disk in the bright graphical form

---

**You can switch between these components by clicking tabs on the left side of the Explorer Bar.**

---

- **Help**, which contains the program help and general information on the product.

You can access the desired information by clicking on the appropriate tab.

The Explorer Bar is a fully-functional embedded HTML browser, which offers the possibility to address, for example, the company’s website to look through important technical notes or download the latest updates without having to close the program.

The program help is also HTML-oriented. You can read it and follow external links from to get additional information.

To easily navigate through browsed pages, the program provides the following functionality:

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>FUNCTIONALITY</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#" alt="Return" /></td>
<td>Return to the previously browsed page</td>
</tr>
<tr>
<td><img src="#" alt="Open" /></td>
<td>Open the next browsed page</td>
</tr>
<tr>
<td><img src="#" alt="Stop" /></td>
<td>Stop loading the current page</td>
</tr>
<tr>
<td><img src="#" alt="Refresh" /></td>
<td>Refresh the contents of the current page</td>
</tr>
</tbody>
</table>

**Partition List**

The Partition List is another helpful tool that enables you to get a clear-cut picture of the current state of the system hard disks/partitions. Partitions are sorted according to their starting position. For every item of the list there is the possibility to call the context-sensitive popup menu with available operations. Besides, the program provides detailed information on all hard disks/partitions found in the system including the following properties:

- Name,
- Volume label (if exists),
- Partition type (Primary/Extended /Logical),
- File system type,
- Size,
- Amount of used and unused (free) space,
- Start/End cylinder,
- Start/End head,
- Start/End sector
- Free size in sectors/bytes
- Active/Inactive attribute
- Hidden/Unhidden attribute

You may customize outlook of the Partition List by clicking on the arrow icon on the top right side of the panel.

By marking a checkbox opposite the required item you can choose whether to display it or not. Besides, you can change its order by pressing the Move up or Move down buttons.

If you don’t need the Disk Map, please click the shown below icon to disable it:

Properties Bar
The Properties Bar provides information on the selected at the moment partition/hard disk:
For a hard disk

- Model,
- Serial number,
- Type of hard disk (basic or dynamic),
- Total size (in GB),
- Information on geometry of the disk (amount of sectors per track, heads and cylinders).

For a partition

- Drive letter assigned to the disk,
- Volume label (if available),
- Type of the logical disk,
- File system (represented by the color of the graph and the selected bar),
- Total size, used space and free space (in GB or MB).

Besides you can modify practically any partition property by clicking on the required value.

Legend Bar

The Legend Bar explains the color scheme used for disk and partition presentation. You can hide (or show) the bar with the appropriate Main Menu item: View > Disk Map Legend. When it is activated it can be found at the bottom of the Explorer Bar.

The program distinguishes between the following types of known file systems:
- FAT16/32
- NTFS
- Linux Ext2/3/4
- Apple HFS

Status Bar

This is the bottom part of the main window. The Status Bar displays menu hints, for each item the cursor points to.

The user can hide (or show) the bar with the appropriate Main Menu item: View > Status Bar.

Settings Overview

The Settings dialog is available from the Main Menu: Tools > Settings. All the settings are grouped into several sections, which functions are described in the following paragraphs. The list of sections is placed on the left side of the dialog. By selecting a section from the list, you can open a set of options.

To get a detailed description to any setting, control, or field of the program just click the hint button and then the object you need.
General Options

This section contains a set of general options that will be taken into account during any operation carried out with the program:

- **Partition Alignment mode.** There are three options you can choose from:
  - **Legacy.** DOS and Windows OSees before Vista required that partitions had to be aligned to the “disk cylinder” or 63 sectors to address and access sectors correctly. It was OK, until 4K hard drives came into scene. When partitions are aligned this way on this type of disk, each logical cluster is linked to two physical 4K clusters, thus resulting in a double read-write operation.
  - **Vista.** Since Windows Vista, operating systems do not use the archaic CHS (cylinder/head/sector) addressing scheme, but the Logical Block Addressing (LBA), where sectors are addressed continuously over the whole disk drive. It is optimal for both, 512B and new 4K disk drivers.
  - **Inheritance.** Select the option to disable automatic alignment of partitions.

- **Check FS integrity policy.** Accomplishment of any data-sensitive operation (resize, move, merge, redistribute, change cluster size, etc.) is potential with data loss. To minimize this risk, it’s recommended to check integrity of your file system before this type of operations, despite the fact that it’s quite time consuming. We offer you several options to let you choose, which is best for you:
  - **Always.** Maximum protection, but minimal performance. The file system integrity will be checked each time it’s necessary to guarantee the maximum protection for the on-disk data.
  - **Once.** Standard protection with acceptable performance. The file system integrity will be checked for each volume only once just before accomplishing data-sensitive operations.
  - **Never.** No protection, but maximum performance. If you’re not 100% sure your disk is rock solid, please do not use this option.

- **Data Loss Protection mode.** To guarantee safety for your information when a data-sensitive operation has been abruptly interrupted as a result of a computer reset, or a power outage, there are several techniques, that correspond to the options below:
  - **Do not protect.** No protection, but maximum performance. If you’re not 100% sure you’re completely safe from a power outage, or an accidental reset of your computer, please do not use this option.
- **Reset.** Standard protection with acceptable performance. Maintaining a special journal, our program enables to automatically complete a data-sensitive operation interrupted by an accidental reset of your computer from our bootable recovery media, thus reviving the corrupted partition.

- **Power loss.** Maximum protection, but minimal performance. Besides journaling, our program will also disable cache of your disk when accomplishing data-sensitive operations to avoid data loss even in case of a power outage.

### General Copy and Backup Options

This section contains a set of options that will be taken into account during copy and backup operations:

- **HDD raw processing.** Mark the checkbox to copy/back up a hard disk in the sector-by-sector mode, thus ignoring its information structure (e.g. unallocated space or unused sectors of existing partitions will be processed as well). This can help to avoid problems with hidden data created by certain applications or the system administrator. However, it will take more time to accomplish the operation.

- **Partition raw processing.** Mark the checkbox to copy a partition in the sector-by-sector mode to successfully process unknown file systems. However it is not recommended to enable this option when working with supported file systems as it takes more time to accomplish the operation.

- **Skip OS auxiliary files.** Mark the checkbox to skip OS auxiliary files (like pagefile.sys, hiberfil.sys, etc.), thus reducing the operation time and the resulted size of the backup image.

- **Automatic BCD Update.** Unmark the checkbox to suppress automatic update of BCD (Boot Configuration Data) after copy/restore operations.
Hot Processing Options

In this section you may configure the hot processing mode:

- **Enable hot processing.** Mark the checkbox to enable the so called hot data processing mode that is specially designed to process data without restarting your operating system.

- **Hot processing technology.** From the pull-down list you can select the required hot processing technology.

- **Always use hot processing.** Select the option to process partitions without making them locked. Thus you will be able to keep working with them as usual.

- **Use hot processing only when partition is locked.** Select the option to use the hot processing only when partitions are locked and cannot be processed without restarting the computer. Please keep in mind, that once you start any operation on a partition in this mode, it will automatically be locked by the program, thus you won't be able to keep working with it as usual.

- **Hot processing temporary drive.** Here you can select a disk drive that will be used to store the temporary hot backup data (by default – C:).

- **Attempts to start VSS.** Here you can set how many attempts to start Microsoft VSS the program is to do before automatically rebooting the system and accomplishing the operation in a special boot-up mode.

- **Timeout between attempts (in seconds).** Here you can set a time period between different attempts to start Microsoft VSS.

- **Switch between hot processing technologies.** Mark the checkbox to automatically switch between Paragon Hot Processing and Microsoft VSS if one of them is unavailable at the moment.

Partitioning Options

This section contains a set of options that will be taken into account during partitioning operations:

- **Request confirmation before partition deletion.** Mark the checkbox to activate an additional security mechanism. Thus when going to delete a partition you will be automatically requested to enter its label.
• **Request confirmation when converting FAT16 to FAT32.** Mark the checkbox to automatically request confirmation before converting FAT16 to FAT32. There are a number of situations when this kind of conversion is the only way out to accomplish the operation. For instance, you are going to migrate your system to a larger hard disk with the proportional resize of existing partitions; what is very convenient. As a result you can get original FAT16 partitions go beyond the 4GB limit. Thus without conversion to FAT32, this operation will in no way be possible to accomplish. The same goes for any copy hard disk/partition or restore hard disk/partition operation involving an extra upsizing.

**E-Mail Options**

This section contains a set of options that will be taken into account during the Send log files and Send e-mail notification operations:

- **Outgoing mail server (SMTP).** To send messages by using the built-in mail client, it is necessary to have access to a computer running an SMTP (Simple Mail Transfer Protocol) server. All outgoing messages are first sent to the SMTP server, which in its turn delivers them to the required recipients. The address may be represented as a traditional Internet host name (e.g.: mail.com) or as an IP numeric address (e.g. xxx.xxx.xxx.xx).

- **User e-mail address.** Specify an e-mail address that has been assigned by the Internet Service Provider or organization's e-mail administrator.

- **My outgoing server requires authentication.** Activate the option to allow the program to make authentication on the server before sending messages.
  - User name. Enter the name that will be used to log in to the e-mail account.
  - Password. Enter the password that will be used to access the mail server.

When you’re ready with the settings, click on the **Send test e-mail** button to check if everything is OK.

**Virtual Mode Options**

In this section you may configure the virtual mode:
• **Allow virtual mode.** Mark the checkbox to enable the virtual mode. It is an effective way of protection from any troubles, since no operation will be executed until confirmation, thus giving you a second chance to weigh all pros and cons of this or that particular operation.

> **We strongly recommend you to enable this mode.**

• **Close progress dialog automatically.** Mark the checkbox to automatically close the progress dialog after accomplishing operations.

### File System Conversion Options

This section contains a set of options that will be taken into account when converting FAT and NTFS file systems. By default, the program takes locale (regional) settings from the system. Problems might occur however because of different standards for file names and file time stamps (Created, Modified and Last Access Time) of NTFS and FATxx file systems.

To tackle problems of that kind you can manually set:

• **Time zone** to use during the convert operation. NTFS keeps file timestamps in GMT (Greenwich Mean Time) while FAT uses a fixed local date and time. The program takes proper account of these differences and enables to adjust timestamp values.

> **An incorrectly chosen time zone might lead to inability to launch certain software.**

• **Language for file names** to use during the convert operation. NTFS stores file names in Unicode while FAT/FAT32 uses ANSI to save short file names (also called the DOS aliases). The codepage information is required for the correct conversion of non-English file names from Unicode to ANSI and vice versa.

> **An incorrectly chosen codepage will certainly result in corruption of non-English file names.**
• **Request confirmation of settings before NTFS < - > FAT/FAT32 conversion.** Mark the checkbox to automatically display the local settings dialog to check and modify (if necessary) the default parameters before launching the convert file system operation.

**Log Files Options**

In this section you can specify a storage life span for the stubact.log file:

- **Infinite** not to empty the file ever;
- **Minimal** to have the file emptied all the time;
- **Custom** to set a certain storage life span for the file. Please note, once the defined period has been expired, the file will be emptied.

We strongly recommend you not to choose the Minimal option, as in case of having problems with the program, our Support Team won't be able to study operation logs, thus help you out.

**Viewing Disk Properties**

The main tool to view in-depth information on the properties of hard disks is the **Disk Map**. It represents the actual state of the computer's hard disks.

Generally the hard disks are represented on the map by rectangular bars, which also contain small-sized bars. The small-sized bars represent logical disks (partitions). When you select a large-sized bar, the **Explorer Bar** displays information about the disk in a bright, graphical form.
The model and serial number of the disk serve as the title of the browsed page. The disk layout is shown in form of a circular graph, where the color of a sector corresponds to a file system of an appropriate partition. On the right you may see a table, which contains the following information:

- Type of hard disk (basic or dynamic),
- Total size (in GB),
- Information on geometry of the disk (amount of sectors per track, heads and cylinders).

Below there is a list of available wizards. If you click a corresponding record the appropriate wizard will be started. All default values for the operation parameters will correspond to the disk’s settings. The list of wizards contains a detailed description of tasks that can be performed by the wizard. This nullifies the possibility of selecting the wrong wizard.

When you select a small-sized bar (i.e. corresponding to a logical disk) the Explorer Bar will display information on it as well. The page title will contain a drive letter, which is assigned to the disk. The disk layout graph will be colored in accordance with the volume ratio of the used space to the free space (the light colored sector). The table on the right will contain the following information:

- Volume label (if available),
- Type of the logical disk,
Data Backup and Rescue

In this chapter you will find all the information necessary to establish a reliable data protection system.

Creating Backup Images

Depending on a type of information you need to protect and the way this information should be processed, the program offers a number of handy backup wizards. To make your job with the program as easy and convenient as possible, all backup wizards share similar work algorithm. By going through steps of the wizard, you configure all the necessary settings to launch the backup operation. To minimize the possibility of making any mistake, the wizard provides auxiliary information on every single option. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

Simple Backup Wizard Startup

- In the Main Menu: select Wizards > Simple Backup

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

Simple Backup Wizard Setup

The wizard offers the following steps to accomplish the backup operation:

- **The object to back up.** You can back up either an entire disk or separate partitions of the disk (primary, extended or logical). In case of backing up an entire disk, you’ve got the possibility to include into the image such disk elements as the Master Boot Record (MBR) and the first track of the hard disk. This can be very helpful for serious disk recovery procedures.

- **Name and location of the resulted image.** Provide a file name for the new image and its exact location. The program automatically offers an easy to understand name containing the date and the time of the archive creation, which can anyway be modified.
The program automatically calculates size of the future archive and informs the user about space available on the selected destination.

- **Archive Comment.** You can add some additional description to the archive that will later help to distinguish it from the others.

**Result**

After the backup operation is completed you receive an image of the selected object. This image is placed into the specified destination, its features defined by the wizard.

**Available operation scenarios:**
- Backing up a hard disk or partition to a network drive
- Backing up a dual boot Mac to an external USB drive

**Restoring System and Data**

The program includes a convenient and reliable restore wizard. With its help you can restore all types of backup images created with the program. It provides easy to understand instructions to configure and perform all the necessary settings. Moreover you can get an in-depth description to any setting, control, or field of the wizard just by clicking the hint button and then the object you need.

**This feature is only available for the bootable recovery environment.**

**Available operation scenarios:**
- Restoring a dual boot Mac from an external USB drive
- Restoring separate files and folders from a backup

**Boot Management**

Our program enables to easily manage several operating systems on one computer with the help of the Boot Manager Setup Wizard. Among the key features of the wizard the following should be mentioned:

- Up to 16 operating systems on one PC;
- Secure adding/removing of the Boot Manager startup record to/from the MBR;
- Auto Boot option to automatically start up the previously chosen OS after a certain time period;
- Hiding of any primary partition except selected at the moment.

**Startup**

- In the Main menu: select **Tools > Setup Boot Manager**...

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

**Setup**

The wizard offers the following steps to accomplish the operation:

- **Boot menu options.** In this section you can switch between the following modes:
  - **Normal mode.** Choose this mode to display the boot menu every time the computer starts up and define a timeout on the expiry of which the program will automatically select the previously chosen item of the menu.
  - **Hidden mode.** Choose this mode not to display the boot menu until pressing a hot key. For this mode you should define a hot key used to enable the Boot Manager and a time period in seconds the startup message will be displayed.

- **Deactivating/Configuring the Boot Manager.** These two options will only be available once the wizard has been completed and launched again. Select the Deactivate option to remove the Boot Manager from the MBR (Master Boot Record) or Configure to modify the previously set parameters of the startup process.
Result
After the Boot Manager Setup Wizard is completed the program updates the original record in the MBR to get control of the booting process and to be able to display the boot menu.

Available operation scenarios:
- Creating Dual Boot Systems

Partition Management
In this chapter you will find all the information necessary to carry out partitioning operations supported by the program.

Basic Partitioning Operations
Here you can learn how to accomplish basic partitioning operations (create, format, delete).

Creating Partitions
The program provides the ability to create a new partition within a block of un-partitioned space.

Restrictions
1. Do not use the Create Partition function in order to undelete the last deleted partition.
2. The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free space on an existing partition to a new partition.
3. The program cannot create new partitions on Dynamic Disks.

Express Create Partition Wizard Startup
- In the Main menu: select Wizards > Express Create Partition…

Create Partition Wizard Startup
- In the Main menu: select Wizards > Create Partition…

Dialog Startup
1. Select a block of free space on the Disk Map;
2. Select in the Main Menu: Partition > Create Partition.
Express Create Partition Wizard Setup

Thanks to a highly intelligent work algorithm, the wizard requires minimal involvement in the operation, thus you only need to choose a method you find the most suitable to create the partition (if several available), which actually differ in the amount of space to allocate. For easy perception, you can see the resulted disk layout on the disk map by selecting this or that mode.

The number of available methods depends on your disk layout.
To learn more on the way the wizard works, please click the corresponding link on the first page of the wizard.

Create Partition Wizard Setup

The wizard offers the following steps to accomplish the operation:

- **Partition destination.** Select a hard disk (if the computer has several hard disks) and then choose position for the future partition on the disk: at the end (preferable), at the beginning or somewhere in the middle between other partitions.
By default, the program allows you to create a new partition only as the last primary or as the last logical drive within the extended partition. However, by activating the advance mode on the first page of the wizard you can remove this restriction that in its turn might result in some boot problems.

- **Partition size.** There is no restriction on size of the future partition, merely depending on space available on the hard disk.

  If there is not enough free space in one block, the wizard enables to redistribute free space, joining all free space blocks together into one united block and moving partitions when necessary. If the total amount of free space is still not enough, it is possible to split a fragment of space from one of the existing partitions, thus resizing it.

If a partition to resize is locked and cannot be processed, the wizard makes the system reboot to create the partition and then automatically boots the system again. (The rebooting mechanism is different for different versions of Windows.)

You can also choose whether the future partition will be primary or logical by marking the appropriate checkbox.

- **Partition properties.** On the next page of the wizard you can set a number of additional parameters:

  - **Partition type.** From the pull-down list select a file system the newly created partition will be formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).
- **Volume label.** Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification.

- **Surface test level.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.

**Dialog Setup**

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Yes button to confirm the operation.

- **Define whether the partition will be Primary, Extended or Logical.** You can choose the desired partition type from the pull-down list. As a matter of fact, the available alternatives fundamentally depend on the selected block of free space - within the Logical free space, only Logical partitions can be created; Within the Primary free space, both Primary partitions or the Extended Partition can be created.

- **Partition Size.** Define the size (in Mb) of the new partition.

- **Free space before.** Define the position (in Mb) of the new partition relative to the beginning of the block of free space.

- **Free space after.** Define the amount of trailing free space (in Mb) at the end of the new partition.

---

**Partition size and position may also be defined by using the drag-and-drop technique. To do that, just carry out the required operation on the Disk Map. The virtual operations are to be available.**

- **File system for new partition.** From the pull-down list select a file system the newly created partition will be formatted to, otherwise the partition will remain unformatted (so that it will not be ready to use).
• **Volume label.** Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification.

• **Drive letter assignment.** The pull-down list contains vacant drive letters that can be associated with the newly formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on the chosen file system, the following options become available:

![Image](image_url)

- **Use OS built-in routine.** Mark the option to restrict the available values according to the used OS.

- **The amount of sectors per cluster.** Define the Cluster Size for the formatted partition with this spinner control.

  Number of available options depends on the selected file system type.

---

**Result**

After the operation is completed you receive a fully functional partition.

**Available operation scenarios:**

- Creating a new partition to detach operating system from the rest of data

---

**Formatting Partitions**

Any partition should contain some file system to be used for keeping data. The process of installing a file system is commonly known as formatting. A huge variety of file systems have been developed these days.

**Supported File Systems**

The program provides the ability to format partitions of the following file systems:

- FAT12 & FAT16
- FAT32
- HFS+
- NTFS
- Ext2
- Ext3
- Ext4
- Linux Swap v. 2
Wizard Startup

- In the Main menu: select Wizards > Format Partition...

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

Dialog Startup

1. Select a partition on the Disk Map;

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

Wizard Setup

The wizard offers the following steps to accomplish the operation:

- **Partition to format.** Select a hard disk (if the computer has several hard disks) and then the required partition to format.

As a result of this operation contents of the selected partition will be lost.

- **Partition properties.** On the next page of the wizard you can set the following partition parameters:
- **Partition type.** From the pull-down list select the desired file system type. In fact, the program displays only those file systems that can correctly be placed to the selected partition, taking its capacity into account.

- **Volume label.** Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification.

- **Drive letter assignment.** The pull-down list contains vacant drive letters that can be associated with the newly formatted partition.

In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to mark the appropriate option at the foot of the page. When it is marked, the next page enables to define:

- **Use OS built-in routine.** Mark the checkbox to restrict the available values according to the used OS.

- **The amount of sectors per cluster.** Define the Cluster Size for the formatted partition with this spinner control.

Number of available options depends on the selected file system type.

**Dialog Setup**

Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Format button to confirm the operation.

- **File system.** From the pull-down list select the desired file system type. In fact, the program displays only those file systems that can correctly be placed to the selected partition, taking its capacity into account.

- **Volume label.** Enter a label for the selected partition in this textual field. It is an irrelevant parameter usually used for drive identification.
In addition, there is the possibility to make further detailed settings (although the default values will do in most cases). To activate the advance mode, you need to click the More options button at the foot of the dialog page. Depending on the chosen file system, the following options become available:

- **Use OS built-in routine.** Mark the checkbox to restrict the available values according to the used OS.
- **The amount of sectors per cluster.** Define the Cluster Size for the formatted partition with this spinner control.

Number of available options depends on the selected file system type.

Result

After the operation is completed you receive a fully functional partition formatted to the specified file system.

**Deleting Partitions**

Wizard Startup

- In the Main menu: select Wizards > Delete Partition...

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

Dialog Startup

In order to start the operation you should take the following steps:

**Launcher**

1. Select a partition on the Disk Map;
2. Select in the Main Menu: Partition > Delete Partition.

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

**Wizard Setup**

The wizard offers the following steps to accomplish the operation:
- **Partition to delete.** Select a hard disk (if the computer has several hard disks) and then the required partition to delete.

![Image](https://example.com/image1.png)

As a result of this operation contents of the selected partition will be lost.

- **Merge free blocks.** As a result of the operation you may get several blocks of the unallocated space on the hard disk. So choose whether to merge them all and place at the beginning of the disk or at the end by selecting the required operation from the pull-down list.

![Image](https://example.com/image2.png)

**Dialog Setup**

Initially the program suggests you just to remove references to the selected partition from the Partition Table.

![Image](https://example.com/image3.png)

- **Enter the volume label to confirm deleting.** To confirm deletion of the selected partition, enter its Volume Label. The current volume label is displayed above.

- **Do not ask volume label next time.** Mark the option to inhibit confirmation next time you start the dialog.
Result
By default, the operation takes only a fraction of a second. However, the program waits until Windows completes the modification of the disk layout.

Advanced Partitioning Operations
Here you can learn how to accomplish advanced partitioning operations.

Merging Partitions
The Merge Partitions Wizard enables to consolidate the disk space, which originally belongs to two adjacent partitions (or additionally separated by free blocks), into a single, larger partition. The order, in which two partitions have been chosen, is important since all contents of the second selected partition will be placed in a folder on the resulted joined partition.

The program provides the ability to merge only NTFS, FAT16 or FAT32 partitions.

Startup
- In the Main menu: select Wizards > Merge Partitions...

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

Setup
The wizard offers the following steps to accomplish the operation:

- **Adjacent partitions to merge.** Click on the left partition of the pair of partitions you need to merge, as the right one will be selected automatically. During the operation all contents of the right partition will be placed in a folder on the resulted joined partition. By default, the program offers an easy-to-understand folder name, which can be customized however.
If a system partition is the right one of the selected pair, Windows OS will become unbootable after the merge operation is over.

Result
After the operation is completed the disk space of the two adjacent partitions will be consolidated.

**Redistributing Unused Space between Partitions**

**Express Resize Partitions Wizard**

The Express Resize Partitions Wizard enables to easily increase free space on one partition by up-taking the unused space of an adjacent partition of your hard disk.

**Startup**

- In the Main menu: select **Wizards > Express Resize Partitions...**

There are other ways to start up this function, please consult the **Interface Overview** chapter to know more on the subject.

**Setup**

The wizard offers the following steps to accomplish the operation:

- **Adjacent partitions to resize.** Click on the left partition of the pair of partitions you need to redistribute the unused space between, as the right one will be selected automatically.

- **Resulted size of partitions.** Redistribute the unused space between the partitions with the slider or manually by entering the required value.
Result
After the operation is completed the unused space between the specified partitions will be redistributed according to your needs.

Available operation scenarios:

- Increasing size of a system partition by taking unused space of an adjacent logical partition
- Resizing partitions of Apple Boot Camp

Redistribute Free Space Wizard
The Redistribute Free Space Wizard helps to increase free space on one partition by up-taking the on-disk unallocated space and the unused space of other partitions. By default, the wizard adds to the target partition all existing blocks of the free space. Besides you can specify partitions to act as a space donor. The wizard will automatically recalculate positions of the partitions and move their contents to new locations.

Startup

- In the Main menu: select Wizards > Redistribute Free Space...

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

Setup
The wizard offers the following steps to accomplish the operation:

- Partition to enlarge. Select a partition, the size of which will be increased at the expense of other partitions. Blocks of the free space (if any) will be automatically added to the target partition.

- Partition to donate. Choose any partition(s) (not only adjacent) to donate free space.
• **Partition size.** By default, the program leaves 50% of the unused space on a partition and removes another 50% to add it to the target partition. However, the size to take can be customized by moving the slider or by manually entering the exact value.

**Result**

After the operation is completed free space of the specified partition will be increased by up-taking the on-disk unallocated space and the unused space of other partitions.

**Undeleting Partitions**

When simply deleting a partition (without additional wiping) disk management software only removes references to it in the Partition Table, thus leaving the possibility to recover it later.

The program enables to find and recover these partitions. A restored partition will be fully functional, as long as other partitions were not created, moved or exceeded the disk space occupied by that partition. That is why the program offers this function only for blocks of free space.

The operation can be accomplished with the Undelete Partition Wizard.

**Startup**

• In the Main Menu: select **Wizards > Undelete Partitions...**

---

There are other ways to start up this function, please consult the [Interface Overview](#) chapter to know more on the subject.
Setup

The wizard offers the following steps to accomplish the undelete partition operation:

- **Free blocks to scan for lost partitions.** Choose a free block from a tree-like list of available hard disks.

- **Search method.** By default, the wizard selects the fastest search method for your operating system. In most cases that will do to find any accidentally deleted partition. However, if you're under Windows XP for instance (the Conventional Search option is selected), but the deleted partition you're looking for has been created with the Disk Management utility under Vista, the wizard won't be able to find this partition, unless you manually select the appropriate option (Quick Search for Partitions Created by Vista or Later OS). Moreover, if the wizard still fails to find the partition you need, you can select the Thorough Search option to scan every single sector in the specified search area to get the most accurate results.

- **File system filter.** By default, the wizard will search for all known file systems. However, by clicking on the appropriate option on the second page of the wizard, you can specify only those file systems you need.

- **A partition to undelete** (if several). By default, the program searches records of any deleted partition ever existed on the selected block of free space. So you can get several partitions to choose from.

**To know more on the available search methods, please use the context sensitive hint system.**
Most likely the required partition will be found first. If so, you may abort the search operation by pressing the Stop search button.

Result
After the operation is completed you receive a fully functional partition.

*Installing a New Operating System*

Getting your computer ready to install a new operating system, especially when it is going to be an additional OS in the system, is a rather complicated task that implies quite a number of operations, from allocating space to create a new partition (resize, redistribution of free space) to formatting of the newly created partition to a particular file system and checking its surface for bad sectors to avoid possible data loss. Operating systems today are being supplied with basic tools of partitioning that only enable to create a partition (in case there is enough unallocated space on the disk) and then format it to the specified file system type. Our program offers a handy Install New OS Wizard to easily carry out all the necessary operations to install a new operating system.

**Startup**

- In the Main menu: select **Wizards > Install New OS...**

  *There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.*

**Setup**

The wizard offers the following steps to accomplish the operation:

- **Partition to install a new operating system.** The program offers two ways of installing a new OS, i.e. to create a new primary partition for it or use an existing one.
Only primary partitions can be used to install an operating system.

- In case the first option has been marked, the wizard enables to specify:

**A hard disk (if several) where a new partition will be created.** Thanks to an advanced program engine it is possible to use unallocated space of the disk (if any) and unused space of existing partitions to create a new partition;

To avoid any possible problems, the new partition will in no way be created as the first partition of the disk which already contains at least one partition.

**And its size.** If there are blocks of the free space on the disk, the wizard will merge them all and allocate the resulted space for a new partition in the first place. If not, it will take 50% of the unused space of an adjacent partition. However, the size to take can be customized by moving the slider.

- In case the second option has been marked, the wizard enables to choose an existing primary partition to install a new operating system.
Your computer may fail if any other OS has already been installed on the selected partition.

- **Partition properties.**

  - **Partition type.** From the pull-down list select the desired file system type. In fact, the program displays only file systems that can be correctly placed to the selected partition, taking its capacity into account.

  - **Drive letter assignment.** The pull-down list contains vacant drive letters that can be associated with the newly formatted partition.

  - **Surface test level.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.

- **OS Label.** Enter a label for the selected partition in the textual field. It will later be used for the drive identification.

Result

As the final step the wizard will offer you to insert a distributive CD/DVD of the new operating system and restart the computer to launch the installation procedure.

The program will update your MBR, so most likely you won’t be able to start up any of the previously installed operating systems. Please launch the Boot Manager Setup Wizard after the installation has been completed to fix this issue.

Available operation scenarios:

- **Creating Dual Boot Systems**
Moving/Resizing Partition

The Move/Resize Partition function allows you to resize or change location of any partition without destroying its data. In order to move/resize a partition you should take the following steps:

1. Select a partition on the Disk Map.
2. Select in the Main menu: Partition > Move/Resize Partition…

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

3. Define parameters of the operation.

- **Volume size.** Define size (in Mb) of the modified partition.
- **Free space before.** Define the partition position (in Mb) relative to the beginning of the available range of disk space.
- **Free space after.** Define the amount of trailing free space (in Mb) at the end of the available range of disk space.
- **Sector to sector move.** Mark the checkbox to move the partition in the sector-by-sector mode to process its unused space as well. This can help to avoid problems with hidden data created by certain applications or the system administrator. However, it will take more time to accomplish the operation.

Partition size and position may also be defined by using the drag-and-drop technique. To do that, just carry out the required operation on the Disk Map. The virtual operations are to be available.

When resizing a FAT16 partition beyond the 2GB limit (maximum file system size), the
partition will automatically be converted to FAT32.

The program enables to enlarge NTFS partitions (system, locked) without rebooting Windows and interrupting its work, providing 100 percent guarantee that your data is kept intact.

4. The operation will be performed immediately after confirmation.

Available operation scenarios:

- Increasing size of a system partition by taking unused space from any other
- Shrinking a system partition to increase size of a data partition

Converting File System

With our program you can change type of the used file system without destroying its data. While performing the operation, it first checks the current file system for consistency and then verifies whether the on-partition data meet the requirements of the desired file system or not. After having passed the testing, the program re-organizes the file system metadata and user files.

The program enables to convert the following file system types:
- FAT16/32 <> NTFS

In order to convert a file system you should take the following steps:

1. Select a partition on the Disk Map.
2. Select in the Main menu: Partition > Convert file system...

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

3. Initially the program suggests some consistent values for all parameters. In most cases, you can just press the Convert button to confirm the operation.

- New file system. From the pull-down list choose a file system you would like to convert to. Actually the program only displays variants available for the operation, taking into account the current parameters of the selected partition and limitations of the used file system.
• **New cluster size.** Define the cluster size for the partition. This parameter can have a profound effect on the overall performance. In a nutshell, larger clusters waste more space, but generally provide for slightly better performance, because of less fragmentation. So be particularly careful with it.

  The cluster size value is expressed in sectors per cluster. To get it in Kbytes, please divide it into half.

  You may only decrease the current cluster size.

• **Surface test level.** Define the level of the surface check to make the program find bad and unstable sectors and mark them unusable in the file system metadata.

  4. The operation will be performed immediately after confirmation.

**Making Logical/Primary**

The program allows you to include a primary partition in the extended partition, or exclude a logical partition from the extended partition, without partition duplication.

In order to change a partition type you should take the following steps:

1. Select a primary or logical partition on the Disk Map.
2. Select in the Main menu: **Partition > Modify > Make Partition Logical/Primary**.

  There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

The Make Primary > Logical option is only available when the selected partition is adjacent to the extended partition and vice versa.

The Make Primary > Logical option of the system partition will result in inability to boot the operating system.

3. The operation will be performed immediately after confirmation.

**Changing Partition Attributes**

This chapter explains how you can change partition attributes (Active flag, Hidden flag, Volume Label, etc.).
**Mark Partition Active/Inactive**

The program enables to set an active/inactive flag for primary partitions of a hard disk. By default, an operating system will boot only if its partition is active or bootable.

In order to mark a partition active/inactive you should take the following steps:

1. Select a primary partition on the Disk Map.
2. Select in the Main Menu: **Partition > Mark Partition as Active/Inactive**.

---

**Information**

There are other ways to start up this function, please consult the **Interface Overview** chapter to know more on the subject.

---

![Warning Message]

3. The operation will be performed immediately after confirmation.

---

**Warning**

There can only be one active partition on a hard disk, otherwise your operating system will fail to boot.

---

**Hide/Unhide Partition**

The program allows you to hide/unhide primary and logical partitions. By default, an operating system does not mount hidden partitions, thus preventing access to their contents.

In order to hide/unhide a partition you should take the following steps:

1. Select a partition on the Disk Map.
2. Select in the Main Menu: **Partition > Hide/Unhide Partition**.

---

**Information**

There are other ways to start up this function, please consult the **Interface Overview** chapter to know more on the subject.

---

3. The operation will be performed immediately after confirmation.

---

**Warning**

It is strongly recommended not to hide the system partition. Otherwise your operating system will fail to boot.
**Set Label of a Partition**

The Partition Label is a small textual field (up to 11 characters) that is located in the partition's boot sector. It is detectable by any partitioning tool and is used for notification purposes only.

In order to change a partition label you should take the following steps:

1. Select a partition on the Disk Map.
2. Select in the Main Menu: **Partition > Modify > Change Volume Label**.

---

**Hard Disk Management**

In this chapter you will find all the information necessary to carry hard disk operations supported by the program.

**Updating MBR**

The program enables to overwrite the current bootable code in the MBR (Master Boot Record) by the standard bootstrap code. This can help to repair a corrupted bootable code of a hard disk resulted from a boot virus attack or a malfunction of boot management software.

In order to update MBR of a hard disk you should take the following steps:

1. Select a hard disk on the Disk Map.
2. Select in the Main Menu: **Hard Disk > Update MBR**.

---
Extra Functionality
This chapter describes the supplementary functionality available in the program.

View Partition/Hard Disk Properties
The program enables to obtain in-depth information on the properties of hard disks and partitions. Besides the general information, such as capacity, used space or file system type it provides the possibility to get info on hard disk geometry, cluster size, exact partition location, etc.

To get properties on a partition/hard disk, please do the following:

2. Select in the Main Menu: Partition/Hard Disk > Properties…

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

In the opened dialog information will be grouped according to its properties, thus by clicking tabs you can get information you need.

Volume Explorer
Volume Explorer is a special tool to browse and export contents of the local mounted/unmounted volumes formatted to FAT16, FAT32, NTFS, Ext2FS, Ext3FS, Ext4FS file systems. Besides it enables to access Paragon backups as regular folders to explorer their contents or to retrieve certain files.

To launch the Volume Explorer you should click Disk View tab in the Explorer Bar and then choose Volume Explorer:
Call the popup menu for the selected file/folder (right click of the mouse button) to export it to some other location (local or network drive, etc.).

Available operation scenarios:
- Restoring separate files and folders from a backup

**Mount Partition**

The program enables to assign or remove drive letters of existing formatted partitions.

**Assign Drive Letter**

In order to mount a partition you should take the following steps:

1. Select a partition on the Disk Map.
2. Select in the Main Menu: **Partition > Assign Drive Letter**...
3. Specify a drive letter for the selected partition. Initially the program suggests some consistent value for this parameter. So you may just press the Yes button to confirm the operation. However you can manually define the required letter by selecting it from the pull-down list of available drive letters.

4. The operation will be performed immediately after confirmation.

**Remove Drive Letter**

In order to un-mount a partition you should take the following steps:

1. Select a partition on the Disk Map.
2. Select in the Main Menu: **Partition > Remove Drive Letter**.

---

**Modifying drive letter of the system partition will result in inability to boot the operating system.**

**After having processed partitions with installed software, some programs may not run properly.**

---

**Test Surface**

The program enables to test surface of existing partitions and blocks of free space for bad or unstable sectors. If found any it automatically marks them unusable in the file system metadata, thus minimizing the risk of data loss.

In order to start the surface test you should take the following steps:

1. Select a partition or a block of free space on the Disk Map.
2. Select in the Main Menu: **Partition > Test Surface**... From the pull-down list choose the level of the surface check.

---

There are other ways to start up this function, please consult the *Interface Overview* chapter to know more on the subject.
4. The operation will be performed immediately after confirmation.

**Check File System Integrity**  
The program allows you to check integrity of a file system. It can be used to detect possible file system errors before performing any operation on a partition.

To start the system integrity check you should take the following steps:

1. Select a partition on the Disk Map.
2. Select in the Main Menu: **Partition > Check File System Integrity**

There are other ways to start up this function, please consult the **Interface Overview** chapter to know more on the subject.

3. The operation will be performed immediately after confirmation.

**Edit/View Sectors**  
With the built-in Edit/View Sectors tool the program enables to view/edit sectors on existing partitions/hard disks providing the possibility to directly access and modify sectors, save and restore sectors from specified files, navigate through the system metadata, etc.

In order to edit/view sectors of a hard disk/partition you should take the following steps:

2. Select in the Main Menu: **Partition/Hard Disk > Edit/View Sectors**.

There are other ways to start up this function, please consult the **Interface Overview** chapter to know more on the subject.
Careless use of the Edit Sectors function may result in the irreversible data corruption.

Send Log Files

The program enables to simplify the procedure of sending support requests to the Paragon Support Team. In case of having difficulties with handling the program, you, with the help of this very function, can address the company support engineers and provide them with all the information they need such as the disk layout, performed operations, etc. in order to tackle the encountered problem. Information of that kind is stored in Log files.

In order to send log files to the Paragon Support Team you should take the following steps:

1. Call the Send Log Files dialog in the Main Menu: **Tools > Send Log Files**;

There are other ways to start up this function, please consult the **Interface Overview** chapter to know more on the subject.

2. Provide a customer name and a product serial number;

By clicking the Send button the built-in mail client will generate a template request with attached compressed log files and then send it to the Paragon Support Team.

---

**Log files do not contain any confidential information on the operating system settings or the user documents.**

The **Send Log Files** function is only available when outgoing mail server (SMTP) and the user e-mail address are properly set. To learn more about it please consult the [Settings Overview chapter](#).

---

**View Logs**

With a handy dialog you can study logs on any operation carried by the program. To make this job as easy as possible, all the information is structurally divided, besides there is the possibility to see the disk layout before and after an operation, what is very convenient.

In order to view logs on carried out operations select in the Main Menu: **Tools > View Log Files**
Typical Scenarios

This chapter lists a number of the most frequently used scenarios that may be accomplished with the program. You can find here useful recommendations and descriptions of operations.

Backup Scenarios

Back up a hard disk or partition to a network drive

To back up an entire hard disk or a separate partition and then place the resulted image to a network share, please do the following:

1. Click the **Simple Backup** item of the Wizards menu.

   There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

2. On the Wizard's Welcome page, click the Next button.

3. On the next page, mark the appropriate option opposite a hard disk's name or a partition’s name depending on the chosen task.
4. Map a network disk to place your backup image to:
   - Call the Map Network Drive dialog by clicking the appropriate button;
   - Click the standard browse button [...] to browse for the required network share or manually enter a path to it;
   - Define a letter from the pull-down list of available drive letters;
   - Mark the checkbox to make this connection permanent. Otherwise it will only be available for the current Windows session;
   - Click the Connect as user button at the foot of the dialog page to specify a user name and password to access the selected network share if necessary.

5. Edit the archive name if necessary.
Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, another network drive needs to be selected.

6. Add comments to your backup describing its contents.

7. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

This operation can also be accomplished with our recovery media.

Backing up a dual boot Mac to an external USB drive
To back up a dual boot Mac (Mac OS X and Windows XP/Vista/7) and then place the resulted image to an external USB drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. Connect an external USB drive to the computer.

3. Restart the computer. It will be automatically started up into the Linux recovery environment (**Normal Mode**), since it’s the only mode that provides support for Mac computers.

4. In the Linux launch menu select **Partition Manager**.

5. Launch the Backup Wizard by selecting in the Main Menu of the program: **Wizards > Backup Wizard**.
6. On the Wizard's Welcome page, click the Next button.

7. On the What to back up page, select your Mac hard disk.

8. On the Backup Destination page, select the **Save data to any local drive or a network share** option.

   Please select how would you like to save the archive:

   - **Save data to any local drives or a network share**
     Choose this option if you want to save your data to local mounted or physical partition, to USB or FireWare external drives and to a mounted network share. You will be prompted to choose a location you want to save the archive to.

   - **Burn data to CD/DVD**
     Choose this option if you want the Wizard to burn the archive to CD or DVD. You will be prompted to choose a CD or DVD RW drive.

9. Select an external USB drive as a backup destination.
10. Edit the archive name if necessary.

Please take into account values of the parameters Estimated archive size and Space available on backup destination - if the archive size exceeds the available space, another drive needs to be selected.

11. Add comments to your backup describing its contents.

12. On the Backup Summary page review all parameters of the operation and modify them if necessary. Click the Next button to start the backup process.

This operation can also be accomplished under Windows.

Recovery Scenarios

Fixing MBR after a boot virus attack

Let’s assume that the MBR (Master Boot Record) of your hard disk has been corrupted as a result of a boot virus attack, thus your system fails to boot.
To fix the MBR of your hard disk, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the Low-Graphics Safe Mode (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

   By default the Normal Mode will be automatically initiated after a 10 second idle period.

3. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

4. On the Wizard’s Welcome page, select the **Correct the Master Boot Record (MBR)** option.

5. On the next page choose the required hard disk from the pull-down list (if several) and then select the **Update the MBR executable code** option.

6. Confirm the operation.
7. After the operation is completed click the Report button to see a well informative summary page. The program also enables to store the resulted report. To do that, just press the Save button and choose the exact location in the opened dialog.

![Reporting dialog](image)

8. Click the Finish button to close Boot Corrector.

9. Reboot the computer.

**Fixing Windows startup ability**

Let’s assume that due to an unknown reason your Windows fails to complete the startup procedure. At first everything seems quite OK, you can see the standard startup messages on the screen, but at some moment it hangs up.

To fix your Windows startup ability, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

   **By default the Normal Mode will be automatically initiated after a 10 second idle period.**

3. In the Linux launch menu select Boot Corrector. You can find it in PTS DOS as well.

4. On the Wizard’s Welcome page, select the **Search for Windows installations to correct** option.
5. On the next page choose the required Windows installation from the list of found installations (if several), then select the **Edit the Boot.ini file** option. If you’re not sure which installation you need, please use the Properties button to get more info on the selected item.

6. Examine the file – maybe that’s where the problem is. If it contains a mistake, correct it by using the appropriate buttons.

7. If the Boot.ini file does not contain any mistake, please return to the Correct Windows Installations page to correct drive letters in the Windows System Registry.
8. On the next page choose a hard disk from the pull-down list (if several), then the required partition. If you’re not sure which installation you need, please use the Properties button to get more info on the selected item.

9. Click the Edit Letters button to correct an existing drive letter or assign a new one in the Windows System Registry.

10. Once you’ve assigned the appropriate drive letter, close the dialog, then click the Apply button.

11. Confirm the operation.
12. After the operation is completed click the Report button to see a well informative summary page. The program also enables to store the resulted report. To do that, just press the Save button and choose the exact location in the opened dialog.

13. Click the Finish button to close Boot Corrector.

**Restoring a dual boot Mac from an external USB drive**

Let’s assume that your Mac fails to boot because of a hard disk malfunction. But you’ve got a backup of your hard disk on an external USB drive. Just replace the failed disk with a new one and carry out a bare metal restore.

To restore a dual boot Mac from a backup image located on an external USB drive, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   *Recovery Media Builder* can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. Connect an external USB drive to the computer.

3. Restart the computer.

4. In the boot menu select **Normal Mode** to use the Linux recovery environment, since it’s the only mode that enables to work with USB devices.

   *By default the Normal Mode will be automatically initiated after a 10 second idle period.*

5. In the Linux launch menu select the Simple Restore Wizard.
6. On the Wizard's Welcome page, click the Next button.

7. On the What to Restore page, click the standard browse button […] to find the required archive. When done, double click on it to select.

8. On the Image Properties page, make sure that you select the correct image by viewing the provided information about the archive.

9. On the next page specify a hard disk to restore the image to.
All contents on disk selected for restoring purposes will be deleted during the operation.

10. On the Restore Summary page you can see your hard disk layout before and after the operation. Click the Next button to initiate the restore process.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

12. After completing the operation close the wizard, and then reboot the computer.

Copying of data from the corrupted system disk to another hard disk

To retrieve valuable information from your hard disk and copy it to another hard disk when the system fails to boot, please do the following:

1. Connect the second hard disk to the computer.
2. Start up the computer from our Linux/DOS recovery media.

Recovery Media Builder can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.
3. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

*By default the Normal Mode will be automatically initiated after a 10 second idle period.*

4. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
5. On the Wizard's Welcome page, click the Next button.
6. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.

8. On the Select Destination Type, choose the way the data will be stored. Select the **Save data to any local drive or a network share** item.
9. On the Select Destination Path page, select a hard disk to copy the data to by pressing the standard browse button [...].

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

This operation can also be accomplished with our recovery media.

Burning of data from the corrupted system disk to CD/DVD

To retrieve valuable information from your hard disk and burn it to CD/DVD when the system fails to boot, please do the following:

1. Start up the computer from our Linux/DOS recovery media.
Recovery Media Builder can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive. To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment, since it’s the only mode that enables to burn CD/DVD discs.

**By default the Normal Mode will be automatically initiated after a 10 second idle period.**

3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.
4. On the Wizard’s Welcome page, click the Next button.
5. Select a disk where the files you need are stored from the pull-down list in the right pane of the page.

6. Select files you want to copy and place them to Clipboard by pressing the left arrow-button. Click the Calc button to estimate the resulted data size.

7. On the Select Destination Type, choose the way the data will be stored. Select the **Burn data to CD/DVD** item.
8. On the Choose a Recorder page, select a recorder from the list of available devices and then set a volume label by entering it in the appropriate field.

9. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

10. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

11. After the operation is completed, close the wizard by pressing the appropriate button.

12. Turn off the computer.

---

**This operation can also be accomplished with our recovery media.**

---

**Copying of data from a backup to the corrupted system partition**

The system fails to boot since some files are damaged. If you have a backup of the system partition, you can recopy these files to make the system be operable again:

1. Start up the computer from our Linux/DOS recovery media.
Recovery Media Builder can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

3. In the Linux launch menu select the File Transfer Wizard. You can find the same wizard in PTS DOS as well.

4. On the Wizard’s Welcome page, click the Next button.

5. Select a disk where the system backup is stored from the pull-down list in the right pane of the page.

6. Double click on the required backup to open.

7. Select files you want to copy and place them to Clipboard by pressing the left arrow-button.
Click the Calc button to estimate the resulted data size.

8. On the Select Destination Type, choose the way the data will be stored. Select the **Save data to any local drive or a network share** item.

   Please select how would you like to save the data:

   - **Save data to any local drives or a network share**
     Choose this option if you want to save your data to local mounted or physical partition, to USB or FireWire external drives and to a mounted network share. You will be prompted to choose a location you want to save the archive to.

   - **Burn data to CD/DVD**
     Choose this option if you want the Wizard to burn the data to CD or DVD. You will be prompted to choose a CD or DVD RW drive.

9. On the Select Destination Path page, select your system disk to copy the data to by pressing the standard browse button [...].

10. On the Transfer Summary page check all parameters of the operation. Click the Next button to accomplish the operation.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.
12. After the operation is completed, close the wizard by pressing the appropriate button.

13. Turn off the computer.

This operation can also be accomplished with our recovery media.

Restoring separate files and folders from a backup
The program provides a very convenient option to access backup archives and restore only data you need (the so called selective restore functionality).

**Volume Explorer**
To restore separate files and folders from a backup image with Volume Explorer, please do the following:

1. Click the Disk View tab and then choose **Volume Explorer**;

2. Browse for the required archive and then open it by double click of the left mouse button.
3. Call the popup menu (right click of the mouse button) for a file/folder you need and then select the Export item.

4. Select a place on the disk where the file/folder will be extracted to.

5. Click the OK button to accomplish the operation.

The current version of the program does not enable to access file archives with Volume Explorer.
Resize Scenarios

Creating a new partition to detach operating system from the rest of data

Let’s assume that you’re a rank and file user who is most likely to have only one hard disk with only one partition (the only partition is always system). To secure yourself against a system malfunction or a virus attack you’ve got nothing to do, but make a backup of the whole partition, which besides the operating system itself contains all your family photos, favorite films and music, program distributives, whatever. As a result you’ll get a very huge backup image. You can easily tackle this issue however by detaching your operating system from the rest of data.

To create a new partition on your hard disk, please do the following:

1. Click the Express Create Partition item of the Wizards menu.

There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.

2. On the Wizard’s Welcome page, click the Next button.

3. Choose a method you find the most suitable to create the partition. The wizard is especially designed to minimize your participation in finding an appropriate place for it and its resulted size. The only thing you’re to do is to choose between several modes. The most relevant thing here is the amount of space that will be allocated for that partition. For easy perception, you can see the resulted disk layout on the disk map by selecting this or that mode.

The number of available methods depends on your disk layout.

To learn more on the way the wizard works, please click the corresponding link on the first page of the wizard.

4. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do with the system partition resize, like we do in our case, you will be asked to restart your computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree.
5. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. After completing the operation your computer will be automatically restarted back to Windows where you can see the newly created NTFS partition. Now you’ve got a place to keep your stuff apart from Windows.

Increasing size of a system partition by taking unused space of an adjacent partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

1. Click the **Express Resize Partitions** item of the Wizards menu.

   **There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.**

2. On the Wizard's Welcome page, click the Next button.

3. Click on your system partition. By doing that, the wizard will automatically select an adjacent partition as well. This partition will later act as a space donor.
If you've got more than two partitions on your hard disk and a partition you need to increase is surrounded by other partitions, you've got the choice to choose which partition will act as a space donor. Just click on the left partition of the pair, as the right one will be selected automatically.

4. Increase size of the system partition with the slider or manually by entering the required value. Please note, when you change size of one partition the size of the other will be changed as well, thus redistributing the unused space between the partitions.

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.

6. That's basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do with the system partition resize, like we do in our case, you will be asked to restart your computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree.
7. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. After completing the operation your computer will be automatically restarted back to Windows where you can see that your system partition is bigger now.

Increasing size of a system partition by taking unused space from any other

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming applications and system updates your system partition has started to suffer from the lack of free space. But one of your partitions has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from any other on-disk partition, please do the following:

1. In the main window select the required hard disk (if several) on the Disk Map.

2. Choose a space donor partition and then call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.
3. In the opened dialog shift the edge of the partition to the right by the drag-and-drop technique. While doing this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by entering the exact size of free space. Click the Yes button to continue.

4. Now you’ve got a block of free space to add to the system partition. You cannot do it directly however, but by carrying out a number of extra move/resize operations.

5. Since the block of free space is within the extended partition, you need to take it out first. The program enables to resize the extended partition only when there’s a block of free space adjoining its borders. In our case it’s between two logical disks. So we need to move it. To do that, please select the first logical partition and then call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.
6. At first shift the right edge of the partition to the right, then do the same with the left edge. Make sure the partition size has been left unchanged.

7. Now you can resize the extended partition to take the block of free space out of it. Call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.

---

Call a context menu for the extended partition (with the blue border), not the logical one.

---

8. In the opened dialog shift the edge of the extended partition to the right.
9. The block of free space has been released.

10. Now you need to move the second primary partition just the way we did it with the logical partition to make the block of free space adjoin the system partition.

11. Finally increase size of the system partition. Call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.

12. In the opened dialog shift the edge of the partition to the right, thus increasing its size.

13. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual Operations Bar.
14. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the appropriate button to agree.

**Increasing size of a system partition by taking unused space of an adjacent logical partition**

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent logical partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To increase size of a system partition by taking unused space from an adjacent partition, please do the following:

1. Click the **Redistribute Free Space** item of the Wizards menu.

   **There are other ways to start up this function, please consult the Interface Overview chapter to know more on the subject.**

2. On the Wizard's Welcome page, click the Next button.

3. Select a volume you want to expand, i.e. the system one.

4. Select a volume to take the space from, i.e. the logical one.

5. On the next page of the wizard you can specify size of the resulted system volume. Drag the slider or type in the exact value to set the volume size.
6. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual Operations Bar.

Separating OS from media data

Let’s assume you’ve got one partition available on the hard disk, like other people who purchase a computer with a preinstalled operating system. So besides OS, it holds all your documents, favorite music, movies and family photos. This type of configuration is certainly not optimal for effective data organization and safety. First, it negatively affects the system: huge amount of data aggravated by its inevitable excessive fragmentation causes poor performance in file search/access and read/write operations. Second, it’s inconvenient for the user: system files and folders piled up with media and documents besides obvious difficulties in transparent organization become a naughty problem in case of a system malfunction.

Split Partition Wizard can help you detach the operating system and data or different types of data by splitting one partition to two different partitions of the same type and file system – you just select a partition, then files and folders you’d like to move to the new partition, finally redistribute free space between the two partitions if necessary, and here you are!

Before you start, please take into account the cases when the split operation is impossible to perform:

- Partition’s type is not supported (you have selected a non-standard primary or logical partition: OEM, MSR, etc.);
- The selected partition is located on a dynamic disk;
- You’ve already got 4 primary partitions on a Basic MBR disk;
- You’ve already got 3 primary partitions on a Hybrid (Retained) GPT+MBR disk;
- There’s not enough free space on the selected partition (free up to 50 MB);
- The selected partition has an unsupported file system (currently only NTFS and FAT file systems are available for splitting).

To detach OS from media files, please do the following:

1. Click the **Split Partition Wizard** item of the Wizards menu.
2. The first page of the wizard informs the user on the upcoming operation. Please read all notes carefully before you proceed. Once you’re done with that, click **Next** to continue.

3. Select a volume you want to split up.

![Image of a volume selection window](image)

**If the wizard cannot work with the selected partition, you’ll get a corresponding notification – click on the “More Info...” link to see the details.**

4. When selecting a system partition (just our case), the wizard notifies that this type of operation may cause inability of the operating system to start up if moving system files/folders to the new partition. So please take it seriously. If you’re sure, confirm the operation.

![Image of a system partition warning](image)

5. Mark checkboxes next to files/folders you’d like to move to the new partition. Please don’t touch system files/folders like “Windows”, “Users”, “Program Files”, config.sys, etc. By clicking the **Next** button, the wizard starts calculating the amount of data to move, which may take some time.

![Image of a file list](image)

6. Redistribute free space between the partitions by moving the slider or manually by entering the required value for the new partition in the corresponding field. Then choose a drive letter for this partition from the pull-down list that contains vacant letters if necessary (by default, the wizard selects the first vacant one).
By default, the wizard allocates all free space to the original partition. You should decide for yourself how much of it should be given to the original and the new partitions. Anyway we strongly recommend you to allow free space on both partitions.

7. Review the changes and complete the wizard.

8. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual Operations Bar.

9. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment.

Merging a system partition with an adjacent logical partition

Let’s assume you’ve got several partitions on your hard disk. After installing a number of resource-consuming applications and system updates your system partition has started to suffer from the lack of free space. But an adjacent logical partition has a plenty of redundant space. That’s just enough to make your system partition suffer no more.

To merge a system partition with an adjacent partition, please do the following:

1. In the main window select the required logical volume on the Disk Map.

2. Call the context menu for it (right click of the mouse button) to launch the Make Partition Primary dialog.
3. Confirm the operation by clicking the Yes button. By default, our program works in the virtual mode of execution, so you can either confirm all operations to let the program accomplish them or continue work in the virtual mode.

4. Click the **Merge Partitions** item of the Wizards menu (any of the ways described earlier can also be used here).

5. On the Wizard's Welcome page, click the Next button.

6. Click on the left partition of the pair of partitions you need to merge, as the right one will be selected automatically. During the operation all contents of the right partition will be placed in a folder on the resulted joined partition. By default, the program offers an easy-to-understand folder name, which can be customized however.

If a system partition is the right one of the selected pair, Windows OS will become unbootable after the merge operation is over.
7. Review the changes and complete the wizard.

8. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual Operations Bar.

9. If you’ve got to do with the system partition resize, like we do in our case, you will be asked to restart your computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree.

10. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. After completing the operation your computer will be automatically restarted back to Windows where you can see that you have the merged volume now.

Shrinking a system partition to increase size of a data partition

Let’s assume you’ve got two partitions on your hard disk, the first one takes about 40% of all the disk space and is exclusively used for Vista 64-bit, while the second servers as a data storage. One day you realize that your system partition doesn’t need so much disk space, that’s what your data partition really requires at the moment. You can easily tackle this problem with Paragon Linux/DOS recovery environment.

To increase size of a data partition by taking unused space from a system partition, please do the following:

1. Start up the computer from our Linux/DOS recovery media.

   **Recovery Media Builder** can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive.

   To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the boot menu select **Normal Mode** to use the Linux recovery environment (more preferable) or **Safe Mode** to use the PTS DOS recovery environment (in case you’ve got problems with Linux). Moreover you’ve got the option to boot into the **Low-Graphics Safe Mode** (PTS DOS safe mode) to cope with a serious hardware incompatibility. In this case, only the minimal set of drivers will be included, like hard disk, monitor, and keyboard drivers. This mode has simple graphics and a simple menu.

   By default the **Normal Mode** will be automatically initiated after a 10 second idle period.

3. In the Linux launch menu select **Partition Manager**. You can find it in PTS DOS as well.
4. In the main window select the required hard disk (if several) on the Disk Map.

5. Choose your system partition and then call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.

6. In the opened dialog set a new size for the partition by moving the slider or by entering the exact value in the appropriate field. While doing this, free space from the partition will be released (displayed in aqua-green). Click OK to continue.

7. Now you’ve got a block of free space to add to your data partition.
8. Choose the data partition and then call the context menu for it (right click of the mouse button) to launch the Move/Resize dialog.

9. Move the slider to the right to increase size of the partition. Click OK to continue.

10. Apply the pending changes.

11. In the Progress window you can see in real-time a detailed report on all actions carried out by the program.

Resizing partitions of Apple Boot Camp

Let’s assume you’re a Boot Camp user who’s got Windows XP as the second operating system. Initially allocated space for the Windows partition has turned out to be insufficient for your current needs. The only way out is to take some space from your Mac partition, thus redistributing the unused space between the partitions.
To increase size of the Windows partition by taking unused space from the Mac partition, please do the following:

1. Click the **Express Resize Partitions** item of the Wizards menu.

   There are other ways to start up this function, please consult the [Interface Overview](#) chapter to know more on the subject.

2. On the Wizard's Welcome page, click the Next button.

3. The wizard will automatically select Windows (the NTFS file system) and Mac (the Apple HFS file system) partitions of your Boot Camp configuration.

   On the disk map you can also see the GPT service partition (called EFI) as well as a 128-megabyte free block between Mac and Windows partitions made with Boot Camp. It’s just for your information.

4. Increase size of your Windows partition with the slider or manually by entering the required value. Please note, when you change size of one partition the size of the other will be changed as well, thus redistributing the unused space between the partitions.

5. On the next page of the wizard you need to confirm the operation by selecting the appropriate option.
6. That’s basically it. By clicking the Next button the wizard will start modifying your disk layout. If you’ve got to do with the system partition resize, like we do in our case, you will be asked to restart your computer in a special boot-up mode to accomplish the operation. So click the appropriate button to agree.

7. In the Progress window you can see in real-time a detailed report on all actions carried out at the moment. After completing the operation your computer will be automatically restarted back to Windows where you can see that your system partition is bigger now.

Creating Dual Boot Systems

For Windows computers

Release of Windows Vista has given a new impetus to the problem of establishing a dual boot system. In this connection we decided to consider two the most frequently used situations a rank and file user may face, i.e. Windows Vista + Windows XP and Windows XP + Windows Vista. Please note that for reasons of better security and system independence these operating systems will be installed on different partitions. That is why we need to hide the first system partition before installation of the second OS.

Windows Vista + Windows XP

Suppose you have got Windows Vista coming with your brand new computer. Everything is great except one thing – your favourite applications simply reject to work correctly on it. Software updates are expected to release in the near future, but you cannot wait any more. Thus the best way out is to leave Windows Vista intact and install the time-proved Windows XP.

Most likely you have only one hard disk with only one partition (the only partition is always system). To install the second operating system you need to repartition your drive first, as it requires a separate primary partition.
Install New OS Wizard

This scenario implies that operating systems will be installed on different partitions to provide better security and system independence.

1. Click the **Install New OS** item of the Wizards menu.

There are other ways to start up this function, please consult the **Interface Overview** chapter to know more on the subject.

2. On the Wizard's Welcome page, click the Next button.

3. Select the appropriate option to create a new primary partition on your hard disk.

4. On the next page of the wizard, define size of the new partition. If the selected hard disk contains blocks of free space, the wizard will automatically merge them all and allocate the resulted space to create the partition. If not, it will take 50% of the unused space of an adjacent partition, thus resizing it.

5. The next page enables to specify a file system and a number of additional parameters. Since we are going to install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.
On this page you can specify a number of additional parameters that can also be of help. However here we pay attention to the most relevant to fulfill our task.

6. Enter a label for the future partition in the textual field. It will later be used for the drive identification.

7. The program will carry out all the necessary operations and then automatically restart the computer to initiate the installation process.

If you’ve changed your mind on installing a new operating system, don’t insert its distributive CD but press ESC when the following message appears:

8. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find all the necessary information in documentation that comes with the product. However to avoid any problems, we consider it necessary to draw your attention on the following issues:

   - You need a bootable distributive CD of Windows XP to install it;
   - To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first or press F12 during startup to select a bootable device;
   - Do not forget to select the newly created partition as destination.

9. So if everything is OK, you’ve got to have by this moment Windows XP successfully installed. Your Windows Vista however is still non-bootable. To fix this issue you need to launch the Boot Manager Setup wizard. To do that, please install our program once again, but this time in Windows XP to activate Boot Manager.
To avoid double installation, please use our recovery media to activate Boot Manager.

10. Click **Boot Management** and then select **Boot Manager** in the Express Launcher.

11. Set up the Boot Manager wizard. The parameters offered by default will do in our case, so just complete the wizard and it will automatically find the two operating systems and update the MBR.

12. Now restart the computer to make sure you have got a dual boot system.

**Traditional way**

This scenario implies that operating systems will be installed on different partitions to provide better security and system independence.

1. In the main window select your hard disk on the Disk Map to make a block of free space on it.

2. Release some free space (not less than 10 GB to install Windows XP) from the partition. To do that, please call the context menu for the selected partition (right click of the mouse button) and launch the Move/Resize dialog.
3. In the opened dialog shift the edge of the partition to the left by the drag-and-drop technique. While doing this, free space from the partition will be released (displayed in aqua-green). You can also do it manually by entering the exact size of free space. Click the Yes button to continue.

4. Now you have a block of free space sufficient in size to hold a new partition.

5. Create a new partition to install Windows XP. To do that, please call the context menu for a newly created block of free space (right click of the mouse button) and launch the Create Partition dialog.
6. Define parameters of the future partition. By all means it has to be primary and since we are going to install Windows XP, the most preferable file systems are NTFS and FAT32. Click the Yes button to continue.

7. As a result of the operation we have got a newly created FAT32 partition just enough in size to comfortably work with Windows XP.
8. Hide the Windows Vista partition to avoid writing any data on it during the Windows XP installation, as it is the best way to provide system independence. To do that, please call the context menu for it (right click of the mouse button) and launch the Hide Partition dialog. Click the Yes button to continue.

![Hide Partition dialog](image)

**Hiding of the system partition will make OS non-bootable, what is quite normal.**

9. Apply all introduced changes. By default, our program works in the virtual mode of execution, so you have to confirm all operations to let the program accomplish them. To do that, just click the Apply button on the Virtual Operations Bar.

![Apply pending changes?](image)

10. The program will require the system restart to accomplish the operation in a special boot-up mode. Click the appropriate button to agree.

**After all the operations are completed you will not be able to restart the system, what is quite normal. Nevertheless if you do try it, the following error will occur:**

```
STOP: c000001a (Fatal System Error)
The initial session process or system process terminated unexpectedly with a status of 0x00000000 (0xc0000034 0x0010037c).
The system has been shut down.
```

11. Install Windows XP on the newly created partition. We won’t go into details as for its installation, as you can find all the necessary information in documentation that comes with the product. However to avoid any problems, we consider it necessary to draw your attention on the following issues:

- You need a bootable distributive CD of Windows XP to install it;
- To automatically start your computer from this CD, make sure the on-board BIOS is set up to boot from CD first or press F12 during startup to select a bootable device;
- Do not forget to select the newly created partition as destination.
Installation of Windows XP will make Windows Vista non-bootable.

12. Launch the Boot Manager Setup wizard. As your Windows Vista is non-bootable any more, you need to install our program once again, but this time in Windows XP to activate Boot Manager.

To avoid double installation, please use our recovery media to activate Boot Manager.

13. Click **Boot Management** and then select **Boot Manager** in the Express Launcher.

14. Set up the Boot Manager wizard. The parameters offered by default will do in our case, so just complete the wizard and it will automatically find the two operating systems and update the MBR.

15. Now restart the computer to make sure you have got a dual boot system.

**Windows XP + Windows Vista**

If you’ve got Windows XP and are willing to try the latest Windows Vista but not sure your favorite applications will flawlessly work on it, the best way out is to leave the time-proved Windows XP intact and install Windows Vista for studying purposes.

As this very situation is very close to the previous one, please use the **Windows Vista + Windows XP** scenario. However please take into consideration one more step you need to accomplish if you decide to use the traditional scenario:

1. Besides hiding of the system partition before installation of the second OS you need to make it inactive as well. To do that, please call the context menu for it (right click of the mouse button) and launch the corresponding dialog. Click the Yes button to continue;
Reviving the system partition

In case you are not able or not willing to complete the mentioned above scenarios, but have already reached the point when all changes are applied and everything is ready to install the second OS, please do the following to make your system bootable once again (only relevant for the traditional scenario):

1. Start up the computer from our Linux/DOS recovery media.

**Recovery Media Builder** can help you prepare our recovery environment either on a CD/DVD disc or a thumb drive.

To automatically boot from the recovery media please make sure the on-board BIOS is set up to boot from CD/USB first.

2. In the Linux launch menu select **Partition Manager**.

3. In the main window select your non-bootable Windows partition on the Disk Map.

4. Unhide the partition by calling the context menu for it (right click of the mouse button) and then selecting **Unhide**.
5. Only for the Windows XP + Windows Vista scenario you need to make the system partition active as well by calling the context menu for it (right click of the mouse button) and then selecting **Set Active**.

6. You will be notified after the operations are completed.

7. Restart the computer.
Troubleshooter

Here you can find answers to the most frequently asked questions that might arise while using the program.

1. I try to run an operation, but the program claims my partition is in use and suggests restarting the computer.
   There are a number of operations that cannot be performed while your partition is in use (or locked in other words). Please agree to reboot your machine to make the program accomplish the operation in a special boot-up mode.

2. I run an operation and restart the machine as required, but it just boots back into Windows without accomplishing the operation.
   Please run 'chkdsk /f' for the partition in question.

3. I cannot create a new partition on the disk.
   There can be a number of reasons for that:
   - The program cannot create a new partition on a dynamic disk.
   - The program allows creating new partitions only within blocks of un-partitioned space. It cannot convert a free space on an existing partition to a new partition.

4. I cannot copy a partition.
   There can be a number of reasons for that:
   - The source or target disk you select is a dynamic disk;
   - 4 primary partitions (or three primary partitions and an extended one) already exist on the target disk.

5. I need to copy a partition. But when selecting a place where to make a copy, I always get a crossed circle sign no matter which partition is selected.
   The program enables to copy a partition only to a block of un-partitioned space. If you don’t have a block of free space on your hard disk, please delete or reduce an existing partition to accomplish the operation.

6. I cannot do anything with my USB flash drive. I get a crossed circle sign when trying to select any area on it.
   Some USB flash drives don’t have the MBR (Master Boot Record), that’s the cause of your problem. To fix the issue please use the Update MBR function of our program or 'fixmbr' of the Windows installation disc to write a standard code to your flash drive.

7. When trying to back up my system the program asks to restart the computer.
   Most likely the Hot Processing mode is disabled. Please make it active in the program settings.

8. When backing up a partition with the VSS (Volume Shadow Copy Service) mode, the program throws "VSS could not be started for processed volume".
   Most likely you try to back up a FAT32 partition, which is not supported by VSS. Please use the Paragon Hot Processing mode instead.

9. I cannot back up my hard disk to an external hard drive. Once started, the operation is aborted with the following error: Hard Disk management, Error Code 0x1100a. What is wrong here?
   The problem is that the Microsoft VSS service is set as the default Hot Processing mode in the program. But this service has not been started in your WindowsXP/Windows2003/Vista. Please start this service (right click on My Computer > Manage > Services > find Microsoft Volume Shadow Copy Service and make it active. Set also to start it automatically).
10. When running a backup operation with the Paragon Hot Processing mode enabled, I get an error: error code 0x1200e "Internal error during Hot Backup"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer’s tool.

You can find a name of the tool you need here: http://kb.paragon-software.com

11. When running a backup operation with the Microsoft VSS mode enabled, I get the following error: error code 0x12016 "VSS: can’t read volume data"

Most likely your hard disk contains bad blocks. Please fix the issue with your HDD manufacturer’s tool.

You can find a name of the tool you need here: http://kb.paragon-software.com

12. When trying to back up to a network share, I get the following error: "i/o error" or "can’t open/create file"

Please check whether you’ve got a permission to write to the selected destination or not.

13. When trying to restore a backup archive, I get the following error: "Can't restore to current selection" or "Archive does not fit"

Most likely you’re trying to restore a backup of the whole hard disk to a partition or vice versa.

14. I set up a timetable for a task, but it fails to execute.

There can be a number of reasons for that:

- Windows Task Scheduler does not work properly. Check whether it is so or not by scheduling a simple task (call Notepad through scheduling);
- You don’t have permission to write to the selected backup destination.

**Glossary**

**Active Partition** is a partition from which an x86-based computer starts up. The active partition must be a primary partition on a basic disk. If you use Windows exclusively, the active partition can be the same as the system volume.

In the DOS partitioning scheme, only primary partitions can be active due to limitations of the standard bootstrap.

The term **backup** originates from the time when the best way to protect valuable information was to store it in form of archives on external media. It’s become now a general notion to mean making duplications of data for protection purposes.

**Bootable Archive** is created by adding a special bootable section when backing up the data to CD/DVDs. Thus you will be able to restore the data from these archives without having to run the program, but by simply booting from these CD/DVDs.

**Cluster** is the smallest amount of disk space that can be allocated to hold a file. All file systems used by Windows organize hard disks based on clusters, which consist of one or more contiguous sectors. The smaller the cluster size, the more efficiently a disk stores information. If no cluster size is specified during formatting, Windows picks defaults based on the size of the volume. These defaults are selected to reduce the amount of space that is lost and the amount of fragmentation on the volume. A cluster is also called an allocation unit.

**Extended Partition** is a partition type you create only on a basic MBR (Master Boot Record) disk. Extended partition is used if you want to create more than four volumes on a disk, since it may contain multiple logical drives.

**File System Metadata**. The servicing structures of a file system, which contain information about allocating files and directories, security information etc, are named the file system metadata. It is invisible for users and regular applications because its accidental modification usually makes a partition unusable.
**Hard Disk Geometry.** Traditionally, the usable space of a hard disk is logically divided into cylinders, cylinders are divided into tracks (or heads), and tracks are divided into sectors.

The triad of values \([\text{Sectors-per-Track}], \text{[Tracks-per-Cylinder]}, \text{[Amount-of-Cylinders]}\) is usually named the Hard Disk Geometry or C/H/S geometry.

Tracks and cylinders are enumerated from "0", while sectors are enumerated from "1". These disk parameters play an essential role in the DOS Partitioning scheme.

Modern hardware uses an advanced scheme for the linear addressing of sectors, which assumes that all on-disk sectors are continuously enumerated from “0”. To allow backward compatibility with older standards, modern hard disks can additionally emulate the C/H/S geometry.

**Hidden Partition.** The concept of a "hidden" partition was introduced in the IBM OS/2 Boot Manager. By default, an operating system does not mount a hidden partition, thus preventing access to its contents.

A method of hiding a partition consists in changing the partition ID value saved in the Partition Table. This is achieved by XOR-ing the partition ID with a 0x10 hexadecimal value.

**Master File Table (MFT)** is a relational database that consists of rows of file records and columns of file attributes. It contains at least one entry for every file on an NTFS volume, including the MFT itself. MFT is similar to a FAT table in a FAT file system.

**MBR & 1st track of the hard disk** is the 0th sector of the disk. MBR (Master Boot Record) contains important information about the disk layout:

- The used partitioning scheme;
- The starting records of the Partition Table;
- The standard bootstrap code (or the initial code of boot managers, disk overlay software or boot viruses).

Generally, the 0th sector is used for similar purposes in all existing partitioning schemes.

The MBR capacity is not sufficient to contain sophisticated boot programs. That’s why the on-boot software is allowed to use the entire 0th track of the disk. For example, boot managing utilities such as LILO, GRUB and Paragon Boot Manager are located in the 0th track.

**Partition ID** (or File system ID) is a file system identifier that is placed in the partition. It is used to quickly detect partitions of supported types. A number of operating systems completely rely on it to distinguish supported partitions.

Partition ID is saved in appropriate entries of the Partition Table and takes only 1 byte of space.

**Partition Label** (or Volume Label) is a small textual field (up to 11 characters) that is located in the partition’s boot sector. This value is used for notification purposes only. It is detectable by any partitioning tool including the DOS FDISK utility.

Modern operating systems save it within a file system, e.g. as a special hidden file. Thus it is able to contain a relatively large amount of text in multiple languages.

**Partitioning Scheme** is a set of rules, constraints and format of the on-disk structures to keep information on partitions located on a hard disk.

There are known several partitioning schemes. The most popular of them is the so-called DOS partitioning scheme. It was introduced by IBM and Microsoft to use multiple partitions in the disk subsystems on IBM PC compatible computers.

Another popular partitioning scheme is the so-called Logical Disks Model (LDM) that originates from the UNIX mainframe systems. Veritas Executive accommodates a simplified version of LDM to the Windows 2000 operating system.
Windows 2000 and XP support two quite different partitioning schemes: the old DOS partitioning scheme and the new Dynamic Disk Management (DDM). The problem is that earlier versions of Windows do not support DDM. In addition, most hard disk utilities do not support it as well.

**Recovery Media** is a CD/DVD disc, a USB flash card or even a floppy disk from which you can boot for maintenance or recovery purposes.

**Root Directory** is the top-level directory of a formatted logical drive to include other files and directories. In modern file systems (Ext2/Ext3, NTFS and even FAT32) it does not differ from other directories. This is not the case for old FAT12 and FAT16 file systems.

**Serial Number.** In the DOS partitioning scheme, every hard disk and every partition has a 32-bit serial number represented by an 8-figure hexadecimal value. It is stored in the MBR and its value is assigned when the MBR sector is initialized by Microsoft standard disk managing tools, such as Windows Disk Administrator and the FDISK utility.

In fact, a hard disk's serial number is not important for most operating systems and software. It is known that Windows NT, 2000 and XP store its value in the database of assigned drive letters.

A partition's serial number is stored in its boot sector (in FAT16, FAT32 and NTFS file systems). Its value is assigned when the partition is formatted. It does not play an important role for most operating systems and software as well.